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Chapter

Introduction

Welcome to the XtractIM User’s Guide. This manual is designed to give you a brief introduction to
the XtractIM application by providing real life examples and demonstrations so you can understand
some of the basic concepts of the XtractIM application.

SYSTEM REQUIREMENTS

Please refer to Installation Guide to check the system requirements.

How 10 USE THIS GUIDE

This guide provides descriptions, demonstration examples and step-by-step instructions on how to get
the desired results with the XtractIM tool.

ADDITIONAL DOCUMENTATION

In addition to this document, refer to the following documentation for additional information.

» .spd File Format Reference Guide explains the format of the Sigrity .spd file. Files must either
be created as a .spf file or translated from another format into .spd file format.

*  Translators User’s Guide explains how to translate layout data contained in various file for-
mats into the Sigrity .spd file format.
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CONVENTIONS USED IN THIS GUIDE

CONVENTION USE

Bold GUI text, special names, terms (window names, buttons, menus,
etc.)

Arial Examples

> Menu hiearchy

How To CONTACT TECHNICAL SUPPORT

We are committed to helping you in using XtractIM. If you have any questions, contact the Cadence
Online Support.

INTRODUCTION 2
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Learning the Basics

This chapter describes the basics of the XtractIM application.

Chapter

UsING XTRACTIM

1. Load a layout file (also called a package file).

2. Create a Workspace.

[ d

N o o &

The Workflow Pane

Run the simulation.
View the results.
Repeat theses steps, as needed, to change your settings.

Run the simulation as many times as you need.

Save the workspace for future use. You’ll use this workspace to prepare for the simula-
tion.

The workspace is made up of the Workflow pane and the Layout Area. All the workflow
tasks are listed in the Workflow pane. Tasks of the same type are sorted and listed together.
When a task is clicked, details associated with that task appear in an Editor pane.

Check results
Modify a design
Report results.

Run a simulation
Set up a simulation
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I
Editor Bar Status Bar Layout Selection Window

+ Editor pane — A spreadsheet. Users can easily input information into the pane for simulation
setup or check the simulation results in the pane.

* Layout Selection Window — Controls the active layer, displayed layers and the object display
on or off.

*  Layout Window — Edit your layout file.

e Status Bar — Shows the version information, the current X-Y coordinates of the cursor and the
simulation progress.

*  Tool Bar — Quick access icons for common XtractIM commands.

Using the Workflow Pane

The Workflow pane includes Manage Workspace, Package Setup, Simulation Setup, and View and Ex-
port Results.

+ Layout Area — Displays the configuration of the layout file.

*  Workflow Tasks — For different packages vary slightly.

LEARNING THE BASICS 4
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Show and Hide Icons

When you click on the Show and Hide icons in toolbar, the selected item is displayed or hidden.

Extractiy - viirebond.xml - [wirebond.spd Layer Wiew]

=2 \Workspace
JdE -

Toggle Workflow Pane

Edit  Wew  Setup  Tools  Window  Help
> m S L
1

Toggle Editor Pane

Net-Based Extraction on Single-BGA Package

Workflow Task

Description

Manage Workspace

Load workspace and/or layout file.

Load Workspace

Load in an existing workspace.

Load a New/Different Layout

Create a new layout file or remove the current layout file and load in a
desired layout file.

Package Setup

Set up all basic parameters for simulation.

Package Type

Wirebond or Flip-chip, Single-BGA or Stacked-BGA.

Circuit Select/deselect Die circuit or Board circuit.
Stackup Setup the Stackup parameter of a package.
Bumps Seup Bumps parameters for a Flip-chip package.
Solder Ball Set Solder Ball parameters.

Nets Select the desired nets for RLC extraction.

Simulation Setup

Module

IBIS/RLGC or Optimized Broadband.

Simulation Type

Choose from Net-based and Pin-based.

View / Export Results

Summary View the RLC matrix, the minimum and maximum R, L, C values.
SPICE/IBIS Model View the SPICE model, IBIS .pkg model and IBIS .ibs Pin model.
RLC Per Net 2D display of R, L and C value for each net.

RLC Distributions

3D display of R, L and C full matrix values.

Segment RLC

View segment RLC on each metal layer.

RLC vs.Net Length

2D Display of R, L, and C, vs. net length for signal nets.

LEARNING THE BASICS
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Workflow Task Description
Crosstalk View the near-ended and far-ended crosstalk among signal nets.
Save Results Save the result on hard disk. A text file and a binary file with the extension

xim will be saved.

Load Results Load in the saved results on display.

LEARNING THE BASICS 6
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Net-Based Extraction on Stacked-BGA Package

Workflow Task

Description

Manage Workspace

Load workspace and/or layout file.

Load Workspace

Load in an existing workspace.

Load a New/Different Layout

Create a new layout file or remove the current layout file and load in a
desired layout file.

Package Setup

Set up all basic parameters for simulation.

Package Type

Wirebond or Flip-chip, Single-BGA or Stacked-BGA.

Circuit Select/deselect Die circuit or Board circuit.
Stackup Setup the Stackup parameter of a package.
Bumps Seup Bumps parameters for a Flip-chip package.
Solder Ball Set Solder Ball parameters.

Nets Select the desired nets for RLC extraction.

Simulation Setup

Module

IBIS/RLGC or Optimized Broadband.

Simulation Type

Choose from Net-based and Pin-based.

View / Export Results

Summary View the minimum and maximum R, L, C values.

SPICE Model View the SPICE model, RLC for each path (Die-toBGA1, Die-to-BGA2,
BGA1-to-BGA2).

Branch RL View each branch R and L of the generalized T-topology circuit.

Save Results

Save the result on hard disk. A text file and a binary file with the extension
xim will be saved.

Load Results

Load in the saved results on display.

LEARNING THE BASICS
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Pin-Based Extraction

Workflow Task

Description

Manage Workspace

Load workspace and/or layout file.

Load Workspace

Load in an existing workspace.

Load a New/Different Layout

Create a new layout file or remove the current layout file and load in a
desired layout file.

Package Setup

Set up all basic parameters for simulation.

Package Type

Wirebond or Flip-chip, Single-BGA or Stacked-BGA.

Circuit Select/deselect Die circuit or Board circuit.
Stackup Setup the Stackup parameter of a package.
Bumps Seup Bumps parameters for a Flip-chip package.
Solder Ball Set Solder Ball parameters.

Nets Select the desired nets for RLC extraction.

Simulation Setup

Module

IBIS/RLGC or Optimized Broadband.

Simulation Type

Pin-based.

View / Export Results

Summary

View the minimum and maximum R, L, C values.

SPICE Model

View the SPICE model.

Working on a Layout File

Working on layout files includes working with package layers, objects, nets, vias, traces, shapes,
nodes, wirebonds, stackups, etc.

1. Open the Attach Layout File window.

LEARNING THE BASICS 8
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&ttach Layout File

Apply current workspace setup

Please choose the tvpe of lavout to load
{*} Load an existing SPD file

{_¥Load an exisking DXF File

(] 4 I | Zancel

2. To apply the current workspace setup, click
Apply current workspace setup

3. To load a desired SPD layout file, click
Load an existing SPD file

4. To load a desired DXF layout file, click
Load an existing DXF layout

LEARNING THE BASICS 9
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.spd File Format

The layout file is in Sigrity .spd file format. As part of the Sigrity family of products, XtractIM in-
cludes file format translators which translate the following file formats in .spd files for simulation.

»  Cadence .brd, .mcm, and .sip files

e (Cadvance .dbr files

*  Mentor BoardStation ASCII design outputs files

*  Mentor Expedition .hkp files

*  Mentor PADS .asc files

* P-CAD .pcb files

e Zuken CADStar & Visula .rif files

e Zuken CR5000 .pcf, .ftf, and .mrf files

File Manager

You may specify the directories where output files of different types are placed.

Tools > Options > Edit Options... > File Manager

I—Options b4
@® N
&) Change the 'General' options in XtractIM
Save Options
igteys ) Automatically Save The Project File
Layout l.a

Grid and Unit Every III minutes

View ? 2

Processing [[] Before simulation starts

Itec . Save the project file automatically to protect against undesired modifications or unexpected exits,

EarChedaig XtractIM allows simulation without saving the file, the auto project file saving is helpful in keeping the
3D Layout View (JD consistency between the design and the result.

Display
Quality
simulation (Basic) ®
General
Met and Coupling
Spedial Void
Qutput SPICE Circuit
Report
Simulation (Advanced) (&)
Electric Models
Mesh
Mets and Shapes

Default | | Apply | | OK | | Cancel

File Folders

* Blackitems — Editable. The default value of the temporary folder is the operating system’s
temporary folder. Other default values include the directory where the current case is located.

* Gray items — Not editable. Indicate current working paths.

LEARNING THE BASICS 10
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File Name Pattern

The names of the output files are customized.

[W] Workspace Name

[L] Layout Design Name
[Y] Year

[M] Month

[D] Day

[h] Hour

[m] Minute

[s] Second

Folder Browser

The Folder Browser goes through files in special folders. Select:

View > Pane > Folder Browser

[ Folder Browser e
 Folder Type Fath =9
4] pkg_fipchip_6 spd
| 4] wirebond.spd
= Wrebond sl
Click on a folder in the |eft side of the Double-click an a file inthe right list to open the
window. The folder contents are file. A pop-up window displays file information
displayed in the right side of the window. the cursor howvers over the filename.

Currently, Sigrity analysis tools do not offer any folder type contain-
ing multiple items.

PREPARE FOR SIMULATION

To prepare for the simulation you need to set all the parameters in the Package setup.

LEARNING THE BASICS 11
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. ~ Symbol next to an item is a reminder that this item has not been set.

« % Symbol next to an item means it has been set.

1. Click on an item under Package Setup in the Workflow pane. Our example shows Solder Ball
selected and displayed.

2.  An Editor pane opens across the bottom of the workspace. You can easily input all information
for the Solder Ball model.

Package Setup - = Solder Ball X
Laver Name Circuit Name Cimax {mm) | D1 {rmm) D2 {mm) HT ) Conductivity (Sfm) Medium Thickness {mm) Solder Ball Model
Solderballol BiaAl 0.5 0.4 0.4 0.4 5.8e7 0.05

Medium Thickness

Cancel

Save Workspace Files

After having gone through each step in the Package setup, you can save the workspace in *.ximx for-
mat. This *.ximx file includes the .spd file name and all the settings in the Package setup.

Since version 12.0, XtractIM workspace file is named with the
NOTE extension “*.ximx”. An .ximx file includes the .spd file name but,
does not include the actual layout of the .spd file.

Save a Workspace
1. To save a newly created workspace, select
Workspace > Save

2. Enter a name for the new workspace.
3. To save the existing workspace under a different name, select

Workspace > Save as

4. Enter the new name.

LEARNING THE BASICS 12
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Load Workspace

1. To load an existing workspace and its associated layout file, select

Load Workspace

2. Ifthe associated layout file does not exist in the same directory as the workspace file, the follow-
ing window opens.

Dpen Layout File ? x

Look in: |L§ Single-Die_Sample_files |v| ) ? ® -
[EITemp

B

* gpkg_flipchip_s00.spd
Py Recent & wirebond, spd
Docurmemts

=]

Desktop

\$

My Documents

tdy Computer

File narne: | pkag_flipchip_B00.=pd | - | | Open |

Py Metwork, Files af type: | Layout File [*.zpd) | - | Cancel

3. Choose the desired layout file from the list shown in this new window. For example:
pkg_flipchip 600.spd.

RUN THE SIMULATION AND VIEW RESULTS

1. Click on the Start icon b‘ in the Toolbar to run the simulation.

XtractIM only extracts RLCG for the net which has at least one pin at the Die side and at least
one pin at the board side.

2. At the beginning of the simulation, if some nets have Die-Board mis-match, a pop-up window
asks you to select the next action.

Continue — Continue the simulation.
e More Information — Lists all mis-matched nets.

LEARNING THE BASICS 13
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+  Stop — Cancel the simulation.

If 30 seconds pass and you have not made a choice, by default,
the simulation continues.

NOTE

3. Choose More Information to investigate mis-matched nets. The information lets you see
whether it is a special design or a defective design. You can then decide whether or not to pro-
ceed with the simulation.

4. To view the results in each selection., select

View > Export Results

LEARNING THE BASICS 14



Learning the Workspace

This section describes how to use the Workspace.

XTRACTIM WORKSPACE

When you launch XtractIM for the first time, the Main Window opens. From this window, you can
create a new workspace. Select

Workspace > New

akxtractib o ®

iFlo o DO E— [ma®miEhRie )
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New Workspace

The new workspace is made up of three major areas:

aextractitd - Untitled - [Untitled Layer view]

@ Workspace  Edt  Wiew  Setup  Tools  Window
Q& H- ™=
* B @ H i ] [% 8
Al Ensbled Ket(s) MGG B
Wiorkflow Rtracti x 5
Default A

)]

Manage Workspace
Load Workspace
Load a Mew/Different Layaut
Package Setup ()
Package Type: Wirebond
A Circuits
W Stackup
# Solder Ball
" Mets
Simulatiun Setup
Module: 1BI5/RLGC
Sirmulation Type: Met-Based

View/Export Results (%)

b

®

Summary
SPICEIBIS Model
RLC Per Met

RLC Distributions
Seament RLC

RLC vs, Met Length
CrossTalk

Load Results

Wer: 4.1.a0.10181 (SHCNE)

Workflow pane — Left side of the screen.
Layout Area — Large blank area on the right side of the screen
Layer Selection and Net Manager Pane — Right side of the screen.

Help -3 ][%
I3 [ :|Extractor Result Bt e » il o) 8]
-] § @ 3 1
=w ’-i‘
Layer Selection X

@ Pl
@ Flaneol
W Signalol

L1 00 fm

w] igw Only Active Layer

Display Geometry Objects By
*Met Colar O Laver Color

| o=l e

Layer Selection

il 3]
(@ Ready

LEARNING THE WORKSPACE

16



XtractlM Workspace

XtractlM User’s Guide 16.6

Workflow Pane

Editor Pane

All Workflow tasks are listed in the Workflow pane. From left to right, the samples show the workflow
for Single-BGA net-based, Stacked-BGA net-based, and pin-based extraction, respectively.

Click on the tasks to expand or collapse them. When a task is expanded, details associated with that
task appear in an Editor pane, across the bottom of the screen.

When you move the mouse onto a task, a tool-tip appears and provides associated information.

 Single-BGA net-based

Multi die or Stacked-BGA net-bazsed

Pin-based

1 Worldlon: KimollM

‘Workflow: AtrackIM

iorkFlows XractIm

= Model Extraclion

Manage Workspace 'E‘)
Load Workspace
Load a Mew/Different Layout

Package Selup =
Package Type: Flo-Chio
Crouits

Stadwp

Burrps

Salde=r Ball

MEtS

Simulation Setup ®
Module: IBIS/RLGC
Simulation Type: Net-Bas=d

View/Export Results (%)
Surmmary
SPICEAIBIS Model
RLC PEr Net
RLC Distributions
SegmentRLC
RLC vz, NetLength
CrossTalk

30 View

Histogram View
Save Reaults
Load Results

AL

Default

B

Manage Workspace 'E‘)
Load warkspace
Load a MewDifferent Layout

Package Setup 'E‘)

Package Twpe: Flip-Chip

Circuits

Stackup

Eunps

Solder Bl

Meks

Simulation Setup 'E‘)
Madule: EISJRLGC
Simulation Type: Met-Based

View|Export Results "E-:)

Sumnnaty
SPICE Madel
Eranch RL

SEANNS

Load Resdlks

Default A
Manage Workspace ':‘9
Load Wotkspace
Load a Mer/Different Layout
Padcage Setup '5:)
Package Tvpe: Fip-Chip
& Ciradits
o Stackup
+ Bumps
« Solder Ball
& Mets
Simulation Setup ":‘)

Modules TATSRLGC
& Simulation Type: Pirrbased
vView/Export Results ":‘)

Surrnay
SPICE Model

Load Resdts

£

L3

When you click on a task, the corresponding detail information of the task is displayed in the Editor
pane (the horizontal section along the bottom of the screen).

1. Input information into the pane.

2. Highlight an item listed in the Editor pane.

3. View the item in the Layer View window.

LEARNING THE WORKSPACE
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THE MENU TOOLBARS

1. To see the all the toolbars available to you, select:

View > Toolbars

2. Use the Status Bar to view:

e Current X, Y coordinates of the cursor
»  Simulation progress
e Version information

3.  Use the commands on the pull-down menus.

*  Check results

*  Modify a design

*  Report results

*  Run the simulation
*  Setup installation

Wigwy | Setup  Tools  Window  Help

Zoom L ﬁ
Shiot L4 44

Layer Selectian, .. EE O+ o mom
3D View " II..l.... |::I.I?|....|....|..
Toolbars v Workspace
Pane k| W Layout
¥ Skatus Bar ¥ Resul
v  Show Ruler
v Checking
v Aukto-bip Circuik
Show Log Files ¥ Object
- W Select
_q— v Shape
‘ v Display
oz | w TCL
NOTE Once a tool is selected, it remains in use until you select another tool.

Right-click to deselect the tool and return to non-drawing mode.

Workspace Toolbar

The Workspace Toolbar provides quick access to common XtractIM commands.

Use this easy access to perform some of the more basic functions of XtractIM.

LEARNING THE WORKSPACE 18
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Start Simulation

Save all Toggle Workflow Pane
WDFRSPHELE |
New(Ctrl+N) RE=R" K (4 = Toggle Output Pane

Open(Ctri+ 0} Stop Simulation

Pause Simulation Toggle Editor Pane

Layout Toolbar

The Layout Toolbar also allows you to perform some of the more basic functions of XtractIM.

Undo and Redo Buttons

You can undo or redo any action that you have performed for package editing.

The Undo and Redo buttons allow you to choose from the last few actions you have performed.

Redo(Ctrl+¥Y) Zoom Back(F3)

1

Layout
Attach a Layout File = i:;_',i i1l [@— Zoom Selected Remz(F7)
1l 1l
' |
Undo(Ctri+2Z2) Fit

Area(F2)

Zoom Functions

Use the zoom functions to view various parts of the package.

1. Select Area to display a magnified view of a rectangular area selected by mouse dragging.
2. Zoom in to a selected area.

3. Zoom-out to display the window contents in reduced size.

4

Select Fit to display the entire curve graph or package in the window.

i
3 = TIP  You can use two hot keys for the zoom-in and zoom-out function: F2 for
area zoom in; F3 for zoom-out.
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The Select Toolbar

At times, the object you want to select for a procedure is so close to another object on a layer that it is
difficult to select the object you want. A special toolbar exists to help you select specific objects.

Select an Object
1. Click on the button for the type of objects you want to select.
2. Select an operation button.

*  Delete — Move the cursor to the objects of interest. Left-click. Hold and drag to select an
object or objects. Click the Delete key to remove objects.

*+  Move — Move the cursor to the objects of interest. Left-click. Selected objects move.

*  Property — Move the cursor to the object of interest. Left-click to select an object. Click on
the Property button to see the Property Report for the object.

*  Select — Move the cursor to the objects of interest. Left-click. Hold and drag to select objects.

*  Unselect — Hold down the CTRL key. Click on the selected object.

Select Via Above

Select Wirebond | Select Node Select
Select Shape Select circuits Move
Select | | |
| all Enabled Netis) v @ = | ok e =W T R by Copy (Ctrl+C)
I I
Select trace | | Turn off all |
all layer via Select pin Property
Select Via Beneath Delete (DELETE)
The Object Toolbar

Use the Object Toolbar to add or cut package objects (vias, shape vertices and Traces).
View the different areas of this toolbar.

These buttons provide quick access to the tasks you will frequently perform.
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Connect via and shape if they belong to the same net

Split Trace Cut Objects on All Layers
Check node with shape ‘ Add Via ‘ Input "what to find"
- l |
Objedt | ] |
Add Node — ™~ H X = H (18 [£] _-ﬁ| |v|;f il — Measure
’ I I |
Add Trace ‘ Add Wirebond ‘ Quick Find Objects
Show Auto Coupled Lines Find Objectz(Ctri+F)
Extend Vias

*  Cut Objects — Cut out objects on all layers in an area that you specify. This function cuts all
objects including: nodes, vias, Traces, shapes, and pads.

* Node Tools — Add a node to the package.
*  Trace Operations — Add or split a Trace and setup a current observation.

*  Via Operations — Add, copy, or extend vias.

Cut Area Rules

When cutting an area, the following rules apply:

*  Objects are cut, regardless if the object’s net is enabled or disabled.
+ Ifanode is used in a circuit link, the node is unlinked prior to being cut.
Shape Toolbar

Use the Shape Toolbar to draw and work with shapes.

Three kinds of shape tools are provided with both add and cut features:

*  Box
+ Circle
* Polygon

The shape tools can be applied to plane layers or patches on signal layers.

Polygen-
Circle- Move Vertex
Box- | |
| |
S I
Shape Process — (7 | [+] (-] &) = #] =] ] @] *] 5] — pelete Vertex
I I
Box+ | | Inser Vertex
Circle+ Show Vertices

Polygen+
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Error Checking Toolbar

Use the Error Checking Toolbar to find short circuit warnings prior to running simulations.

Open (_:irt:uit Check All Layers

=

Floating Modes —@ . E] [Fz] — Reveal Errors
I I

Short Circuit Check

LEARNING THE WORKSPACE 22



Working with SPD Layout

For SPD layout settings, please refer to the common document SPD Layout UG. It introduces the
common GUI capabilities and operations of Sigrity analysis tools.
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Chapter

XtractiM Simulation of a Single BGA Package

This chapter takes you through the steps to use the XtractIM tool in the simulation of a single
BGA (Board Grid Array) package.

ABouUT XTRACTIM

XtractIM extracts the most common electrical models of IC packages according to IBIS (I/O
Buffer Information Specification) as well as SPICE netlist of electrical models.

These models can be used for system-level analysis including drivers, receivers and intercon-
nects; as well as for assessing the electrical performance of IC packages. XtractIM function-
ality provides the user with capability to:

Generate IBIS package pin RLC model.

Generate IBIS package RLC matrix model with coupling between signal, power
and ground nets.

Generate net length, DC_R, delay of each signal net.

Generate SPICE equivalent circuits of package RLGC models of different topol-
ogies (Pi or T), including coupling between signal, power and ground nets.

2D and 3D display of RLC curves and distributions, including coupling between
nets.

XtractIM can handle both flip-chip packages and wirebond packages with 3D bonding wire
profiles. XtractIM handles both single and stacked BGA packages.

It can extract models of full packages or selected nets of a package. The interface is compat-
ible with data files in various formats, including UPD (Unified Package Designer), MCM,
.brd, .sip, NA2, DSN and SPD.

Related Topics

*  The Workflow Pane
*  Using the Workflow Pane

*  Save a Workspace

25
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Toolbar Icons

+  Toggle Workflow pane — Workflow pane appears or hides.
» Toggle Edit pane — Status Bar appears or hides.
*  Toggle Output Pane — Output Pane appears or hides.

Extractib - Wwirebond. xml - [wirebond.spd Layer Wiew]

4 Myorkspace  Edit Wiew  Setup Tools  Window  Help

A5 H- (g m= i L
I
Toggle Workflow Pane | Toggle Cutput Pane

Toggle Editor Pane

SIMULATION SETUP
A typical workflow in Interaction mode includes the following steps.
*  Create a new workspace file or load an existing file (.ximx file).
*  Open a layout file (.spd file).
*  Select a package type: wirebond or flip-chip, single BGA or stacked BGA.
*  Setup the circuits: select / deselect Die-circuit and Board circuit.
*  Setup the Stackup: set parameters for the C4 Bump/Solderball medium layer.
»  Set the Bump data if it is a flip-chip package.
*  Set the Solder Ball data.
»  Select the nets for extraction.

*  Setup extraction frequency and capacitance or inductance output control.

XTRACTIM SIMULATION OF A SINGLE BGA PACKAGE 26
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Setup the Package Simulation

1. Launch XtractIM.

Two icons are available: New A and Open — .

The New icon creates a new workspace.

The Open icon allows users to load an existing workspace file.
2. To create a new workspace click on the New icon;

or select

Workspace > New
3. To load the Package Structure, click on

Load a New/Different Layout

Related Topic
*  Working on a Layout File

XTRACTIM SIMULATION OF A SINGLE BGA PACKAGE 27
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Select Package Type
1. Select a Package Type.
The default package type is Single Die, Single BGA, wirebond package.
2. Click on
Wirebond
or
Flip-chip

Our example shows the Flip-chip selected.

I—“Xtracth - Untitled - [pkg_flipchip_s.spd Laver Wiew]

<& Workspace  Edit Wiew  Setup  Tools  Window  Help -
RR=N" R =] 3 & :|Extractor Result - '3 By igg 2t @ b Gl T
Ceellm:d &l [+ All Enabled Mets) v @ =y oAk EE e =om | -
+ W | al [ [X] & O i @ e S @ E

Warkflow: BirackIm X -

Default 3

*

Layer Selection

SignalDz

S 111
Signal$vDD
Signal$vss
Signal§hi4
Signalol

Manage Workspace "’_y

Load Workspace
Load a Mew/Different Layaut

Package Setup ';}‘

LI
m|[m|[O|m|miO0

A Circuits
A Stackup
¥ Bumps
A Solder Ball
" Mets
Simulation Setup (A)
Madule: IBIS/RLGC
Simulation Type: MNet-Based
View/Export Results (&)
Summary
SPICE[IBIS Madel
RLC Per Met
RLC Distributions
Segment RLC
RLC ws, Met Length
CrossTalk

Load Results

| e Cinly Ackive Layer

Display Geometry Objecks By
*) Metk Color Layer Color

B - @A

Layet Selection

Package Setup - > Package Type X
) Single Die Stacked Die Side-by-side Die
=) Single BGA Stacked BGA Leadframe
‘Wirebond ) Flip-Chip Both
Cancel
Yer: 4,1,2,12215 (SHCMS) Mouselmm): ¥: 2,004, ¥: -10,546 6 Ready

3. Click OK to save your selection.

4. Click Cancel if you want to change your selection, start over and cancel your session.
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Setup Circuits

1. Click on Circuits in the Workflow pane to setup the Circuit data for a Flip-Chip package. A new
pane opens up in the left side of the workspace.

{eractiM - FipChip 2l - kg fiipchip_6.spd Layer View!
& Wokspace Edt  View Mode Sewp Took Mindow  Hep _181x
0O EEH - > B ool — |- - F) £ [ | Bdractor Result ~|1B ‘B B Fom{ut - [Taun HEEETEIE
Al Enabled Nets) @ =] ks F e o=ow R 3 EER: == = f [ [E] 4 Y Pl wigads @E Q@O E: &
Wiizard x 10 - 2 5 o[ ~ | [Net Manager x
- ~ B (£

Select the Die/Component aircuit from the list and cick Next Default Mode -

[ Net Uit (Sort enabled first) * ” nterface

CktName Ckt Model Die /Board/Compo. .. Binet_s0
o Capoi02 Anet e
c3 Capo402 Einet 62
c4 Cap0402 BiNet 63
s Caposo2 Einet 64
c6 Cap0402 Hinet 55
Z =2 Binet 56
Ut FC Dic et 67
BGAL untitled_pac... | Board i Net 65

et o8
et 99
Enet_100
LIPWRGND

im0 core LB

K EEEE R R R EE E R R R E R E EEE R E R E R E R R R E R R R R R
Iy
=
.
o

b v
[ il ]
Right-ciick on a crcuit name to select/deselect as Die drcuit General

[ keep shape enabled when the net is disa

Hide Disabled

[ Gray Disabled
= e Caneel s |Circuit/Linka | Net Manager

Ver: 12.020.11173 (SHCNg) Mouseqmm): X: -0.177, Y: -0.483 @ Ready

2. Right-click on the desired circuit.

3. Select it as a Die circuit (or a Capacitor circuit).
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‘I?HGZHL? RlipChip 2ami - [pkg_flipet spd Layer View]
@ Wokspace Edt  View Mode Setp Tooks Window Help _18]x

D& - > B ooome il — | &
All Enbled Net(s) RGNS SE UG SR
Wizard
r

Net Manager x

Net: -5
Select the Die/Component circuit from the list and dick Next Default Mode -
['Net List (Sort enabled first) * ” Interface
B Net 60

ANet 61

Einet 62

Einet 63

HEinet 64

Hnet 65

Einet 66

Binet 67

Hilnet 63

Enet 69

Einet 70

ANet 71

et 72

Binet 73

Binet 74

Einet 75

Binet 76

Binet_77

Einet_78

Binet_79

Einet_80

ZINet_81

Hlnet_82

Einet 83

Einet 84

Hiinet 85

Enet 85 T
Enet 87
Einet 83
Binet_s9
Binet_so
et 51
B net 52
Banet o3
BNt 54
Binet o5
Binet o6
Binet 57
HEnet 58
HEnet 99
Eanet_100
=|PwWRGND

Ckt Name Ckt Model Die/Board/Compo. ..
S

Select as Die cirout

Select as Capacitor circuit

gpegee

s Cap0402

FC Die
BGAT untitled_pac...  Goard

Right-dlick on a circit name to select/deselect as Die crauit General

7] Keep shape enabled when the netis discl
Hide Disabled

] Gray Disabled

hiext Cancel
hiext > ancel T 2| Net Manager

Ver: 12.0.20.11173 (SHCNg) Mouse(mm): X: -12.408, Y: 0.098 @ Ready

4. Click Next.
5. Right-click on another desired circuit.

6. Select it as a Board circuit.
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I-“)(tractwl - Untitled - [pkg_flipchip_6.spd Layer Wisw]

<& Workspace  Edit  Wiew  Setup  Tools  Window  Help

=15

0 & H- l ommiE 0 @ :|Extractor Result MEE Bs a3 e »inl - @I EE
i &l ¢ Al Enabled Metis) MG I R S
N B & [ [# 44 P Rie e @ E
Wizard X 10 ‘-B : ‘-4 ; 2 10| Layer Selection X
W Signallz (|
Select the Board circuit from the list and click Finish = 2
W SignalfvDD u
Ckt Mame Ckt Madel Dig/Board/Campo. .. W Signal§vss (|
BGAL untitled_pac... Die ‘W SignalfM4 o
U1 FC W Signalll [m}
c7 Cap|  5elect as Board circuit
a3} Cap
E5) Caporoe
4 Cap0402
() Cap0402
2 Cap0402
C1 Cap0402
=]
< Back Cancel
| View Only Active Layer
Display Geometry Objects By
*1Met Color ) Laver Color
= |
iy o -
[ Right-click on a circuit name to selectjdeselect as Board circuic J @BE @ m
= Laver Selection
Yer: 4.1,2,12213 (SHCNE) A TMousefmm): X -11,76, 1 14,934 .a Ready

7. Click Finish to finish the setup.
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Setup Stackup

1. Click on Stackup. The Stackup window opens.

2. Right-click on the bottom signal layer. You can insert layers above or under.

You can insert:

*  Solder
*  Empty

@Stackup ¢
| Layer Icon | LayerName = Thidkness(mm) Conductivity(S/m) Color Trace Width{mm) ShapeMame @ Permittivity = Loss Tangent | From Fie = Mater
= =RELE 5.0000e-003  5.000000e+007 [] 1.00002-001 | A
[esse | BumpOl 1.0000e-001 T | 11.0000 0.0000 0O B
=n = 1.5000e-002  5.800000e+007 [ 1.0000e-001 | | O
| | Medumédi... 1.2500e-001 | | | i4.2000 0.0000 O
= 1= 2.0000e-002  5.800000e+007 [ 1.0000e-001 ShapesvDD | | O
[E0000] Medumsdi...  2.5000e-001 T | 14,2000 0.0000 O e
B soalsvss 2.0000e002  5.3000002+007 [] 1.00002-001 ShapesVss | | O B
[0 ] Medumsdi.. 1.2500e-001 | ; 14,2000 0.0000 O
S W= ol ol e L0006 007 | [10000e001 | | ! .

Insert Above *

Insert Under Signal Layer

Delete Medium Layer

Flane Layer
Solderball Medium Layer, Signal0l Layer, and Medium01 Layer l BGAL |
<] T T
Total Thickness: ~ 6.7500e-001 mm Unit: [mm | »
Right-dlick on a dielectric(or signal) layer to insert a bump or solder bal

[ soider Ball Layer [+] Bump Layer layer. Import l oK J | Cancel

Ball Medium Layer
Signal Layer

*  Medium Layer standing for a PCB Medium Layer

All layers are inserted under the bottom signal layer as shown in the example below. The added signal

layer is the end o

Setup Bump

The example sho

f the solder ball.

ws the setup for a Flip-chip package.

1. Click on Bumps in the Workflow pane. A new window opens up in the Editor pane.
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Package Setup - Bumps
Laver Mame Circuit Mame Dmax {mm) | D1 {mm}) D2 {mm}) HT «mm}) Conduckivity {Sfm})
Bump01 L 0.1 0.1 0.1 0.1 5.8e7
oK || Cancel |
Ver: 4.1,3.02141 (51G4) @ Ready
2. Input the settings for the Bumps.

3.

Maximum Diameter: Dmax (mm)
D1 (mm)

D2 (mm)

Height: HT (mm)

Conductivity (S/m)

Click OK to save your entries or click Cancel if you do not want to save your changes.

Setup Flip-chip Package

1.

To setup the Solder Ball data for a Flip-Chip package, click Solder Ball in the Workflow pane
under Package Setup, A new pane opens up in the bottom portion of the window.
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I-“XtractIM - FlipChip sl - [pke_flipchip_g.spd Laver Wiew]

<& ‘Workspace  Edit  View  Setup  Tools  Window  Help S
JE |- b m 3 [ Extractor Resul MEE Bz LRt e b iuml 3- OO
& Enbkdhes |7 @l = 3 &=« = w | @R Tk
+® EoE OB [F | 2 -0 HigedE @ E
Workflow: ¥trackIM |-12 . ‘-10 ‘ l-B . lB . ‘-4 ‘ |-2 . lD . |2 . |4 . ‘B ‘ lS . |1D . ‘12 Layer Selection X
Default _E ® signallz O
Manage Workspace (4 E.‘_ A signial ~

Load Warkspace _E W Signal$vDD u

Load a MewfDifferent Layout z W Signalivss 0

Package Setup &) 78 W Signal§ie u

Package Type: Flip-Chip W Signalnl (]

" Circuits W Signaln3 O
+ Stackup

Y4

t

\-/
\-/
Simulation Setup &)

Module: IBISRLGC
Simulation Type: Net-Based

Z

View/Export Results '{‘.‘

0

Summary
SPICE/IEIS Model
RLC Per Met

RLC Distribtions
Segment RLC

RLC ws, MNet Length
CrossTalk

Load Results

<«
a
ol

| View Only Active Layer

Display Geometry Objects By
#) et Color O Layer Color

Se=E - emE

| Il I Layer Selection

a-

Package Setup - = Solder Ball X
Layer Mame Circuit Name Dmax imm) | D1 {mm) D2 {mm}) HT {mm} Conductivity {5fm) Medium Thickness {mm) Solder Ball Model
Solderballol BaAL 0.5 0.4 0.4 0.4 5.8e7 0.05

—D2—H

Medium Thickness

Cancel

Yer: 4.1,2,12213 (SHCNE) A TMouse(mm): ¥: 4,346, ¥: -10,561 d Ready

2. Input the settings for the C4 Bumps.
Maximum Diameter: Dmax (mm)
D1 (mm)
D2 (mm)
Height: HT (mm)
Conductivity (S/m)

3. Click OK to save your entries or Cancel if you do not want to save your changes.
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Setup Nets

1. Click on Nets in the Workflow window. The Net Manager window opens.

"Met Manager - O x|

Net: | | - | Default Mode | v|

Met List (Sort enabled first) * " Interface
A Unnamed Met(s)
= BA PowerMets
B vODcore =

Elvoo_1
B voD 2
~1voD_3
B voD_4
= #4 GroundNets
|- NES
L] DEFALLT
Bainet 1
ElNet_2
Elnet_3
Elnet_4
ElMet_5
Elnet_s
Elnet 7
Elnet_s
Elnet o
ElmMet_10
IMet_11
Eiimet_12
Elnet 13
Eiinet_14
= = -

[ T |
eneral
Keep shape enabled when the net is disabled

Gray Disabled [ Hide Disabled
Layer Selection | Circuit/Linkage ... [Met Manager

2. Choose any desired nets for RLC extraction.

You can also move the signal net into and out of PowerNets and Ground Nets.

* At least one Ground Net must be selected to act as a reference ground net.
*  Only choose the desired Ground Net as the reference ground net.

3. To set up Extraction Frequency and Capacitance/Inductance Output Control for identfying cou-
pled Trace, click

Auto Coupled Line
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r |
Met Manager - O =

et | )

Met List {Sort enabled first) * | Rise Time (ps) " %Coupling
2 Unnamed Met(s)
= B rowerhets
g VDDcore
Elvoo_1
B voD_2
LAvDD_3
B voo_4
= 4 GroundMets
B vss
| DEFAULT
Elinet 1
Elnet_2
e = ]

Show Coupled l| - |

EEEEEEEEEEESR

HEEE

U'IU'IU'IU'IU'Ilﬂlﬂlﬂlﬂlﬂlﬂlﬂilﬂlﬂlﬂlﬂlﬂlﬂlﬂlﬂlﬂlﬂlﬂlﬂ

Elnet_s 100
Elnet s 100
Elnet 7 100
Hlnet_s 100
Elnet_o 100
Elnet_10 100
AMet_11 100
Elnet_12 100
ERnet 13 100
Binet_14 100
B met_15 100
Eanet_15 100
—General
Keep shape enabled when the net is disabled
Gray Disabled []Hide Disabled

—Coupled Lines
[] Disable Coupled Line Simulation

Coupled Lines Report
Layer Selection | Circuit/Linkage Manager | Met Manager

4. Select the nets you wish to edit.

5. Right-click to open the pop-menu.
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IHEEEEEEEEEE
[
=
i)

—General
Keep shape en
[ Gray Disabled

—Coupled Lines—
"] Disable Coupled

Enupled Lines R.eg

Layer Selection | C

Enable Selected Mets
Disable Selected Nets
Enable All Mets
Disable All Nets

Edit Coupling Parameters
Delete Coupling Parameters
Set With Default Paremeters

Clazsify
Detect Associated Mets

Mew
Delete
Rename
Import ...

Merge Selected Nets
Split Open Nets

3D View Walk Through
Property

sabled

der Ball Iy
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Set With Default Parameters

1. Select the net to be edited.
2. Right-click

A pop-up menu opens.

Enable Selected MNets
Winet| Disable Selected Nets
Enet) Enable All Nets
ZiMet|  Disable Al Nets

5| Net: Edit Coupling Parameters
B et Delete Coupling Parameters
EdNet,  5g with Default Parameters

EENENEEEEE

BEnet
B Net | Classify ’
B net
Detect Associated Nets
—General
Keep shape en, New
[] Gray Disabled Delete sabled
—Coupled Lines— Rename
[] pisable Couple Import...
E oupled Lines Rep
Merge Selected Nets

Layer Selection | C Split Open Mets

3D View Walk Through ==
Property der Ball I

3. Select
Set With Default Parameters

Rise Time and % Coupling

When Traces are identified as coupled lines, the crosstalk between these lines are calculated during the
simulation.

Coupled lines are treated as multi-conductor transmission lines, whereas an isolated Trace is modeled
by the single transmission line algorithm. Coupled lines can be selected after the relevant Traces have
been placed.

* Rise Time Value — Must be greater than 0. Default value is 200 ps.
* % Coupling Value — Must be 0 < value < 100. Default value is 5%.

NOTE! If the coupling parameters—%Coupling and Rise Time—are left blank,
the trace-to-trace coupling is not calculated during simulation.

Based on electrical threshold parameters, Traces belonging to several nets are automatically identified
and analyzed as coupled transmission line sections.

Two Traces are said to be coupled if their reverse crosstalk exceeds the %Coupling.

For a given Rise Time, the accumulated coupled section lengths between Trace nets should be long
enough for forward crosstalk to exceed the %Coupling.
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Show Coupled Lines

1. Select

Net Manager > Show coupled line > Coupled lines report

A progress window appears to show you the progress.

Auto Coupled Line Formation in Progress

Processing traces ...

- 23%: |

2. The Trace identified as coupled lines is displayed as shown in the following example.
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-

gyCoupled Line Mavigation x
e [T < Widas D
[ Electrical Param. [[] #-5ection Highlight

Physical Parameters
SCPLOA N =2 Coupled Section Length = 017742 mm

Trace Lawver Mame SeparationiHori, )
TraceS37_Aukto 700 Met_31~5%L1 SignalgMi1 {1
TraceS9y i ket_4-.5YL1 Signal§Mi 0. 16163mm

EXTRACTION FREQUENCY AND CAPACITANCE/INDUCTANCE OUTPUT CONTROL

You can change the extraction frequency. The default value is 30MHz. Use the window shown in the
exaple to change the default value.

Follow these steps:
1. Select
Setup > Extraction Frequency

The Extraction Frequency window opens.

Extraction Frequency X

Extraction Frequency: 100 MHz E

Cancel
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2. Set frequency in the pop-up window.

Set Threshold for Exporting Mutual Terms

XtractIM captures all the coupling during the extraction stage. It has options to reduce the size of the
output circuit during the export stage.

1. Open
Setup-> Threshold for Exporting Coupling Terms

A pop-up window opens.

Threshold for Exporting Coupling Terrms »

Mumber of strongest neighbors to expork

In addition,

Ignore rutual L if the ratio of mutual over self terms is less than |0.005

Ignore mutual i the ratio of mutual over self terms is less than |0.005

(04 | | Cancel |

2. Enter the number of strongest coupling neighbors to be kept in the circuit model.

The default of number of strongest coupling neighbors is 10; which means only outputting the 10
strongest neighbors (including self).

3. Ignore mutual capacitance or inductance if the ratio of mutual terms over self term is less than a
percentage.

The default percentage threshold for ignoring mutual capacitance or inductance is 0.005.

If the mutual capacitance/inductance is less than the 0.5% of the minimum of the two self-
capacitances/inductances,

XtractIM will not output the mutual capacitance/inductance.

Save the Workspace and Layout File

On the Toolbar, click the " next to the Save button , the drop-down list shows up. You can

choose to save workspace file or layout file.

Workspace  Edit  Miew  Setup
j I.j H T dd | 4

| Save Workspace File ﬁ

| Enahle Save Layout File i
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*  Select Save Workspace File, the workspace file is saved.

=

*  Select Save Layout File, or click the Save button
Options dialog opens.

, the XtractIM Layout File Saving

¥tractld Lavout File Saving Options

Shape Processing

Error Checking
[] skip Warnings in Error Log File

K, I | Cancel
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Using the Save as Option

The example below shows another way to save the workspace and layout file using the Save as option.

Saving the workspace does not automatically save the .spd file. Similarly, saving the .spd file does not
save the workspace file.

1. Select

Workspace > Save As...

The Save Workspace File window opens.

Save Workspace File

Save in: |['f} Stacked-BGA_Sample_files |v| + ] ?‘ " -.-

Ty | PoP_Flipchip
4 E} [Z| PoP_flipchip-1
My Recent || POP _wirebond
Documents

Degktop

)

ty Documents

o

by Computer

File narne: | | - | | Save I
by Nletwcurk Save as ype: | Eutractor wWorkspace =ML Files [*.xml) | - | Cancel

2. Enter a name.

3. Click Save.

OBSERVE AND SAVE RESULTS

XtractIM calculates each net resistance, self loop inductance, conductance, self capacitance as well
as its mutual loop inductance and mutual capacitance with other nets.

In the Inductance Matrix, the Diagonal Element is the Self Inductance of each net; the off-diagonal
elements are mutual Inductance. The inductance and capacitance are matrices. For example, a simple
group of four nets has the following inductance and capacitance matrix.

(Liy Ly L Ly | (Ciy Cu Cis G |
Lyy Ly Ly Ly Cy G G G
Ly Ly Lsz Ly Gy Cp G Gy
_L41 Ly Lys L+1_ _C“ Cp Cy Cyu
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Capacitance Matrix

The two concepts of capacitance matrix: Maxwell capacitance matrix and SPICE capacitance matrix.

*  Maxwell Capacitance Matrix — Each diagonal element is the loading capacitance (i.e.,
capacitance to ground when other nets are grounded which represents the worst-case capacitive
loading). Off-diagonal elements are mutual capacitance with negative values.

*  SPICE Capacitance Matrix — Each diagonal element is capacitance to ground. Off-diagonal
elements are mutual capacitance with positive values.

The relationship between Maxwell capacitance and SPICE capacitance matrix is shown here:

Capacitance Example
C;(SPICE ) =-C  ,(Maxwell )
C, (Maxwell ) =" C, (SPICE )

C,(SPICE) =3 C,(Maxwell )

RLC Per Net View

Choose to view resistance, self-inductance, self-capacitance or mutual for each net. Usually conduc-
tance is very low; so there is no view for conductance.

*  Mutual Term View — Mutual inductance or SPICE mutual capacitance.

* Self Term View — Resistance, self-inductance or Maxwell diagonal capacitance.
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Self Terms View

< XiractIM - FiipChip 2omi - [Resistance]

( H pgz;:m (Ohm) Extractor Result
£ \
== i T [ \
1 ERN A N Y 1 -
el M A T : JINRE
S AR TR AR R NSRRI
LU R L (L
I AL CULIE AL A
’ AR R0 R
. ! il f [
| |
008 ! !V

XTRACTIM SIMULATION OF A SINGLE BGA PACKAGE 45



Observe and Save Results XtractlM User’s Guide 16.6

Mutual Terms View

Sextractiy - FlipChip.xml - [Inductance]

- 0O x
& \Workspace  Wiew  Window  Help E
_1 Lj H -] Al | d = Lj §|Extract0rResuIt |'|'@ B % % _‘I" @ b
WéorkFlow: BbractIM x| '@®see g T M EF i [2¥ §|Mutual Terms |'|Inductance |'|
Default A Present Curves
Manage Workspace (&) E. Sl et Inductance (nH) Extractor Result
Load Workspace
4 i Mutual Terms ; ;
Load a Mew/Different L?yout {Net1 ¥DD_t) | |
Package Setup ® 1M ¢netz_voo_2) i |
M (wets_voo_s 14— 4= r-
+F Circuits M (ret4_voD_4) i i
" Stackup D. ({MetS_YDDcore) : :
" Bumps El. (MNeté_Met_1) | 1
+ Solder Bal LI (ruet7 et _2) P N L L
o Mets LI (reets it _3) : ] K i
Simulation Setup ®) L1 (it rist_4) i | |
I iretio_met_s) | | |
Modkle: IBIS{RLGC CIml (et 11 net_6) | i i
Simulation Type: Net-Bafed D. (Mek12_Pet_7) U S _l[ ________ IF_
View/Export Results  (~) I iret1s_met_s) ! !
Summary D. (Met14_Met_9) : :
SPICE/IBIS Model | efheRiE Mkt ! !
RLC Per Net Loaded Curves gad--J1-_] _:[ ________ :F_
RL Distributions I I
Segrent RLC : :
RLC s, Net Length i i
CrossTalk : :
Sawve Results 024115 Ti B A r—
Load Resulks : :
I I
¥ I 1
Customize WDrkﬂOWl : :
0 i .
20 an 100
—e—MNet1_¥DD_1
Wer: 4,1,3.02141 (51G4) Mouselmm): =: 15,127, ¥: 12,805 O Ready
Summary of the Extracted Results
Click on Summary to open the summary and tabulated data for R, L and C.
*  Bottom right window — Displays a complete row of the R / L / C matrices when a certain
net is chosen. You can also reorder the list.
»  Top right window — Displays the overall results including package name, nets extracted,

extraction frequency, maximum / minimum R, L, C and the full RLC matrix.

Click on R/L/C heading. The values are listed in increase or decrease order. The Table Content (RLC
Full matrix) is automatically saved on hard disk in .csv format.
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XtractlIM Summary.

aextractib - Flipchip.xml - [Summary] _ O x
b Fle  Window  Help =]
PN E - . = Q___§|ExtractorResuIt |'|'@ B % .:EB _1" e
‘WiatkFlow: XtractIM X | Extractor Result
Default || [Version] 0 o Eeapeas s
— [DTate] 01/20/2011 ]
™
Manage Workspace —) [Fackage Name] C:\SigritydamplestSpeedPEG 4.1\ EtractIM Samples) Single-Die_
Load Warkspace [Description] C:\SigritydamplestSpeedPEG 4.1\ EtractIM Samples) Single-Die_
Load a Mew/(Different Layout [Mets Extracted] 105
Package Setup l{a [Fregquency of Extraction] J0MH=z
Package Type: Flip-Chip [Max R (mOhm) ] 31z, 408 1
o Cireuits [Min E(mChm)] 3.99941
o [Max self-inductance L (nH)] g.70572
v i [Min self-inductance L (nH)] 0.306726
o [Max self-capacitance C(pF)] 39.0554
o [Min self-capacitance C(pF)] 0.495727 L8
Simulation Setup ka
Madule: IBIS/RLGC | i = |
Simulation Type: Net-Based Met Met R{mohm) L{rH) C(pF)
View/Export Results (&) YDD_1 YDD_1 11.1517 1.01241 18.2667
VDD _2 VDD _2 0 1] 0
5 _ .
S:;“crgalrgls Mol YDD_3 =|| vop_3 0 0 0
! L ¥DD_4 YDD_4 0 i 0
RLC Per Met YDDcore YDDcore 0 ] 0
RLC Distributions Met_1 Met_1 1] i) 1]
Seqgrnent RLC Met_2 Met_2 1] 1] 1]
RLC ws, Mek Length Met_3 Met_3 (1] 0.179736 0.414133
CrassTalk Met_4 Met_4 0 0389996 0.446551
Met 5 Met_5 L] 0.777261 0.536162
= Result: = =
La"'deResults Net_6 | et 6 0 0.643644 0.552145
Qe BESENS hek_7 | Net_7 0 0 0
¥ Met_& i Net_s 0 0.158633 0.339077
Met_9 Met_9 0 i 0
Met_10 Met_10 0 i 0
Met_11 Met_11 0 i 0
Met_12 et 12 0 0 0
Met_13 Met_13 0 0 0
Met_14 Met_14 L] 0.751352 0.700147
Met_15 Met_15 0 i 0
Met_16 Met_16 L] 0.451408 0.686555
Met_17 Met_17 0 0 0
Met_18 Met_18 0 i 0
Met_19 Met_19 0 0 0
Met 20 Met 20 1] 0 1]
War: 4,1.2, 12213 (SHCME) IMouse(mnn): ¥: -13.787, ¥ 10,089 Q Ready
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File Example

B Microsoft Excel - pke_flipchip_6_T... [= |[B)X]
i) fle Edit View Jnsert Format Tools Data Window

i Help

HRRER" RETR NRRSRIR RE 15 11 121 RN

-0 X

o IR IS RS TISRSYE Y 2

Al - £ Neti
A B | ¢ | D C F a

T[Veti INetj  Rj (mOhmLij(H) Cij (pF)
"2 [VDD_1_VDD_1 375523 133335 17.3092

3|VvDD 1 Net 5 1.08321 0.398697

4 VDD 1 Net 14 1.051 0518955

5 |VDD 1 Net 32 1.01675 0397362

6 [VDD_1 Net_6 0.661468 0.41072
7 |VDD_1  Net_41 0.800441 0.204633

VDD 1  Net 16 0 602553 0509207

9 VDD 1 Net 31 0.540265  0.0607

10 [VDD_1  Net_ 4 0.526196 0.328424

11|VDD_1  Net_15 0334126 0.0241

12 |VDD_1 Met_8 0.268975 0.244139

13|vDD 2 VDD_2 363296 1186 18519

14|VDD 2  Net 35 0940149 0606868

15 |VDD_2  Net_55 0694187 0494193

16 [VDD_2  Net_50 0.689056 0.398466

17 |VDD_2 Met_45 0858216 0457411

18 |VDD_2  Net 54 0.856756 0.403705

19 |VDD_ 2  Net 62 0.847576 0.533051

20 (VDD_2  Net_49 0673875 0.179802

21(VDD_2  Net_B5 0.673127 0.178135

22 VDD_2 Met_43 0537349 0.290531

23|VDD_2  Net 63 0489275 0.374008

24 (VDD 2  Net 72 0.345013 0.329168 v
4 4 » wn’\ pkg_flipchip_6_TableConte | ¢ |

i Draw~ k¢ | AutoShapes- N\ W [ O ] [id 4 ¢ (8] [& q

-
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SPICE and IBIS Models
Upon completing the simulation both are in the same directory as the .spd file.
*  SPICE Model is saved as a SPICE sub-circuit with the extension .ckt.
+ IBIS Model is saved as an IBIS package model with the extension .pkg.

The total number of each element in the circuit is displayed along the bottom of the window.

« R
- L
e M
« C

e G where M is the mutual inductance

-
etractith - FlipChip.xml - [Circuit Topology Result] _ O =
‘> File  ‘Window  Help = ]&] IZI
R Rr=N RN S | PR . N e N §|Extract0rResuIt |'|'@ 2 H B g Bl e »

‘Wwiorkflow: BtractIM X | | Extractor Result |
Default &
Manage Workspace @ —Wiew Maodel Selectio
Load Warkspace (3 SPICE T-model
Load a MewDifferent Layout € SPICE Pimadel
Package Setup @
g i ) IBIS .pkg model
Package Type: Flip-Chip
o Circuits ) Pitymodel: 1BIS farmat
" Stackup
o Bumps ) Pirymodel: Excel format
v O DC Resistance
" Mets
Simulation Setup )] LSUBCET FlipChip pkg flipchip 6 SPICE t -
ey iy e, o —|
Madule: BIS/RLGC + U1 _U1-E3 BGAl BGA1-C1
Simulation Type: Net-Based *+ Uis 0L a7 BGAL BCAL A3
= F, + Ui _U1-E10 BGAl BGAl-Clz
View/Export Results (%) + U1 _U1-Eé& EGA1 BGAL-K&
Summary + U1 _U1-D4 BGAl BGAL-C3
SPICE/IBIS Model + U1l Ui-L1 BGAl BGAl-LZ
RLZC Per Met + Ui _U1-K1 BGAl BGAL-J3
RLC Distributions + U1 _U1-G5 BGAl BGA1-J1
Segment RLC + 71 _U1-H1 BGAl BGAl-HZ
RLC ws. Met Length + U1 _U1-G1 BGAl BGAL-GZ
CrossTalk + U1 _U1-E1 BGAl BGAL-EZ
Save Resulks + 71 _U1-D1 EGAl BGAL-E3
Load Results + 71 _U1-C1 BGAl BGAl-D2
x + 71 _U1-E1 BGAl BGAL-CZ
+ U1 U1l-Mz BGAl BGAL-MZ
+ U1 U1l-Kz BGAl BGA1-L1
+ Ul _Ti-J2 BEGAl BGAl-H4
+ U1 Ul-Hz BGAl BGALI-GS
+ U1 Ul-Gz2 BGAl BGALI-F1
+ Tl T1-E2 EGALl BGAL1-FS v
4 1] b
Total rumber of circuit components: F:210 L 210 M 1210 C 215 G 36

Ver: 4,1.2,12213 {SHCNE) Mouse(mm): ¥: -13.787, ¥: 10,089 O Ready
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SPICE / IBIS Model Result View

Below is the SPICE / IBIS Model result view.
*  The SPICE model is a PI-circuit.

*  The IBIS model is shown with coupling.

sbstractléd - FlipChip.xml - [Circuit Topology Result]

o L
‘> File  ‘Window  Help E
NE - E e : [Extractor Result BRI e b
wtorkflow: strackIM ¥ | Ezxtractor Result |
Default £
Manage Workspace @ —iew Model Selectio
Load Workspace I SPICE T-madel
Load & Mew|Different L?yout ©) SPICE Pimadel
Package Setup @
3 5 + |BIS .pkg model
Package Type: Flip-Chip
" Circuits ) Pin model: [BIS format
" Stackup
« B 2 Piry model: Exesl format
) DC Resistance
'
Simulation Setup (=) | =
| ol o o ol o o o o o ol o ol o o o ol ol ol o ol o ol o ol e o o o ol |
Module: IBIS/RLGC
Simulation Type: Met-Based I
i @ [IBIS WVer] 5.0
View/Export Results [Comment Char] | char
Surmmary [File Name] ibis flipchip pkg flipchip 6.pkg
SPICESIBIS Model [File Revw] 1.0
RLZ Per Met [Date] 1/20/2011
RLC Distributions [Fource] Sigricy SpeedPEG Suite XtractIM Version 4.1.2.12213
Segment RLC [Notes] One-Section RLC
RLC ws, Met Length [Dizclaimer] The model given below represents a 105-pin package.
CrossTalk [Copyright]
Save Results |
Load Results R e L L ]
Customize Workflow ¥ |
[efine Package Model] ibis flipehip pkg flipehip 6
[Manufacturer] nare 1
[CEM] nare 2
[escription] 105-pin Package
|
| [Mukber of Sections] 1
[Nunwber of Pins] 105 -
Total number of circuit components: R:105 L:105 M:E08 C:213
Ver: 4.1.2,12213 (SHZME) Mouseimrm): ¥: -13.787, ¥: 10,089 0 Ready
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Pin Model: Excel Format

In the SPICE/IBIS Model window, click

Pin Model: Excel format

A .csv file is loaded. It includeds this information for each net. Self-C is the Maxwell Capacitance.

DC R
Net length
Net name
Pin name

Self-C
Self-L
Self-R

SetractiM - FlipChip.xml - [Circuit Topology Result]

‘> File  Window Help

RN A" RANT N | = = §|ExtractorResuIt |'|'@ By ﬁ @ b
‘orkFlow: strackIf X | | Extractor Result |

Default 2

Manage Workspace (’:‘)

Load Workspace
Load a Mew)Different Layout

Package Setup ®)
Package Type: Flip-Chip
" Circuits
" Stackup
L
+F Mets
Simulation Setup )]

Module: IBISIRLGC
Sinulation Type: Met-Based

View/Export Results (’D

Summary
SPICE/IBIS Model
RLC Per Met

RLC Distributions
Segment RLC

RLC vs, Met Lengkh
CrossTalk

Save Results

Load Resulks

4%

Ver: 4.1,2,12213 (SHCNE)

) SPICE T-model
2 SPICE Pimoded
O IBIS pkg mods]
) Piry rodek 1BIS format
* Pin model: Excel farmat
0 DC Fesistance
PinMame MetMame MNetLengthlmm) SelfR[Ohm) SelfL[nH] SelfCpF) Drelay[ps]
BGAT-C1:BGAT-.. ¥DD_1 0.0111517 1.00241 18.2667 13599
BGAT-A3;BGAT-.. ¥DD_2 0.0102248 0.907861 19.8208 134144
BGA1-C12; BGA.. ¥DD_3 0.0106824 0.960092 19.1304 136,526 [
BGATKE BGAT-.. VDD_4 0.0103718 0.928585 19.7203 135.322
BGA1-C3 BGAT-.. ¥DDcore 0.00399941 0.306726 39.0554 109.45
BGATL2 MNet_1 9.78878 0.218146 6.433 1.01491 80.8017
BGATI3 Net_2 7.03801 0.140301 4.2693 0.849707 £0.23
BGAT-1 Net_3 12,6627 0.295479 7.89193 1.33262 102.552
BGATH2 Net_4 8.50694 0.182736 5.93211 0.922568 7349782
BGATG2 Net_5 7.88406 0.165153 5.22156 0.83004 E2.1718
BGATEZ Net_6 8.35208 0.176814 551613 0.922112 71.3196
BGATER Net_7 E.5E27E 0.130305 422513 0.788775 57.7294
BG&1D2 Net_8 862617 0.185649 5.68008 0.949029 73.4204
BGAT-C2 MNet_9 9.0939 0.197461 589651 0.953805 74.9942
BGATMZ Net_10 11.3715 0.263713 743 1.18475 95,7797
BGA1-L1 Net_11 12.0044 0.278254 7.84506 1.25644 93.2815
BGAT-H4 Net_12 5.44875 0.0977836 31543 0.724434 47.8025
BGAT-GE Net_13 257473 0.0274021 1.44504 0.495727 26.7645
BGAT-F1 MNet_14 101332 0.225123 6.43432 1.0865 54.0004
BGAT-FE Net_15 3.63951 0.0486726 2.0824 0.550119 33.8463
BGA1-D1 Net_16 10.9788 0.247073 7.15291 1.14137 90.3554
BGA1D3 Net_17 812182 0.169652 471835 0.930793 B8.3733
BGATEZ Net_18 10.0307 0.222467 6.73338 1.04455 84.2743
BGAT-IE Net_19 4.80254 0.0809202 29M23 0.641788 43,1506
BGATL3 Net_20 9.77622 0.21302 E.10918 1.06783 80.7687
DA LR Rlar 1 E FOROC niAnNaAR173 2 aFoCT no347377 AQ OF
1}
Mouse(mm): ¥ -13.787, ¥: 10,089 O Ready

—Yiew Model Selection———————

XTRACTIM SIMULATION OF A SINGLE BGA PACKAGE 51



Observe and Save Results XtractlM User’s Guide 16.6

RLC Distributions

To see the full matrix value of R, L and C, click
RLC Distributions

RLC Distributions offers eight kinds of views.

I—“Xtratth - FlipChip.xml - [Spatial Wiew]

& workspace iem Display Operation window Help — =[x
= > = T Extractor Result ~ |1y By a5 | @ b
“hforkFlov: KbrackIM * | #|tnductance ~ | Al Terms -~ 2 LL | = = By R

Default # || RLC Distributions

Manage Workspace () L Walue

Load Workspace
Load a Mew/Different Layaut

Package Setup ()

Package Tvpe: Flip-Chip
W Circuits
" Stackup
+" Bumps
v [Solder Ball |

Simulation Setup l':‘)
Module: IBIS/RLGC
Sirnulation Type: Met-Based

View,/Export Results ()
Surmmary
SPICE[IEIS Model
RLC Per MNet
RLC Distributions
Segment RLC
RLC ws, Met Length
CrossTalk
Save Results
Load Results

Y Mouselmm): ¥ -13.757, ¥ 10,039 @ Ready

Segment RLC

For each signal net, XtractIM outputs the segment RLC of each metal layer.

Click on Segment RLC in the workflow pane (under View / Export Results). The Segment RLC val-
ues are shown at the bottom of the window.

There are three bars for Resistance, Inductance or Capacitance. Click on the Resistance, Inductance or
Capacitance bar. The related values are displayed.
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I
|
1‘ File  ‘Window  Help — =[x
U5 - L T Extractor Resulk MEERER SRS E R
‘WorkFlows BtractIiM X | | Extractor Result
Default %
N N Pintd ame SignalMeth ame Signal$t1[0bm] | Signal$¥DD(0km) | Signal$wSS[0hm] | Signal$k4{0hbm] i
Manage Workspace = BGATLZ Net_1 0150109 0.0111254 0.00946153 0.0119596
Load Workspace BGATJ3 Net_2 011236 0.010766 0.00345127 0.0119596
Load a MewDifferent Layout BGATI Net_3 0245925 0.010766 0.00345127 0.0119596
- BGATHZ Net_4 0147416 0.010766 0.00945127 0.0119596
BGAT-GZ Net 5 0133487 0.0107647 0.00349005 0.011958
: BGATE2 Net 6 0144806 0.010766 0.00949127 0.0119596
5 BGA1ES Net_7 0100455 0.0106971 0.0034525 0.0119613 8
o« Stackp BGA1-DZ Net_8 0151882 0.0107647 0.00349005 0.011958 3
+ Bumps BGA1-C2 Net_9 0163308 0.0107647 0.0034E071 0.011958
BGATMZ Net_10 0220419 0.0107647 0.00349005 0.011958
VA olter Al BGATLT Net_11 0.235636 0.0107673 0.0094925 0.0119613
o Nets ) BGATHY Net_12 0.0709525 0.010766 0.00949127 0.0119596
Simulation Setup o) BGA1-GE Net_13 000542952 0.00840557 0.00756766 0.0124606
BGATFT Net_14 0189002 0.010766 0.00949127 0.0119596
Module: JBIS{RLGC BGATFS Net_15 0.023299 0.0134646 0.00349165 0.011958 i
Simulation Type: Net-Based BGAT1DT Net_16 0209214 0.010766 0.009491 27 0.0119596
View/Export Results (%) BGA1-D3 Net_17 0137268 0.010766 0.00949127 0.0119596
BGA1B2 Net_18 0176629 0.0178275 0.00345193 0.0119596
Summary BGAT5 Net_19 0.0565564 0.0107647 0.00349005 0.011958
SPICE/IBLS Model BGATL3 Net_20 0178104 0.0107673 0.00946315 0.0119613
RLC Per Met BGATHS Net_21 0.071978 0.00613949 0.00509164 0.026999
RLC Distributions BGATEZ Net_22 0.20084 0.0107647 0.00345071 0.011958
Seqment RLC BGATH3 Net_23 0123366 0.0107673 0.00345315 0.0119613
RLC ve. Nt Langth BGATE4 Net_24 00815805 0.0106953 0.00345127 0.0119596
P BGATE Net_25 0.24245 0.0107673 0.0094525 0.0119613
e BGAT-A2 Net_26 0237424 0.0107647 0.00949005 0.011958
Save Results BGAT-CY Net_27 01124001 0.0107647 0.00349005 0.011958
Laad Results BGATKS Net_28 010m 0.0107647 0.00349005 0.011958
v1| | BEatLe Net_29 0168097 0.010766 0.00345127 0.0119596
BGATHS Net_30 0138505 0.0107647 0.00949005 0.011958
BGAT-G4 Net_31 0.0842866 0.0106953 0.0034E071 0.011958
BGATF2 Net_32 0163217 0.0107647 0.00349005 0.011958
BGA1B3 Net_33 0193488 0.0107673 0.00946315 0.0119613
BGA1-DE Net_34 0.0715071 0.0107647 0.00345005 0.011958
BGAT-A4 Net_35 0218256 0.0107647 0.00349005 0.011958
BGAT-JE Net_36 0.0506351 0.0116911 0.00945127 0.0119596
BGATHE Net_37 00226582 0.0122219 0.0035416 0.0119613
BGATLE Net_38 0166616 0.010766 0.00949127 0.0119596
LOzAY kdd Rl 30 N2220FF nninzcazy NNNaAQNNE. NN110r0
Resistance[0hm]
Ver: 4.1.3.02141 {51G4) Mouselmm): ¥: -15,127, ¥: 12,805 @ Ready

SAVE RESULTS
1. In the Workflow pane (under View / Export Results), click

Save Results

The Save Extractor Result window appears.
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Save Extractor Result A=

Sawve in; | 2 Single-Die_Sample_filez | v| . |

1 [Z] cPU_Infa
LI = Flipchip
My Fiecent I@FIi|:|l::hi|:u:k.g_l“li|:|chip_Eu_DlZZF‘,esistance
Documents I%FIi|:|lZZhi|:u:l<.g|_FIi|:n:hi|:_E~_F‘inr\’Il:n:IeI
= I%FIi|:|Chi|:u:kg_|‘|i|:u:hi|:_E-_Snagrnentl:
L% I@F|i|:|lChi|:u:I<.g|_|“Ii|:n:hip_lfu_SegmenI:L
Deskiop IEFIi|:|l::hi|:u:kg|_|“|i|:|chi|:_Eu_SegmenI:FL
I%FIi|:|Chi|:|J:kg_l‘Ii|:u:hi|:_E-_signal_xtalk
. &= Flipchip_pka_flipchip_6_sPICE okt
.—j F|i|:lChipjkg_ﬂipthip_ﬁ_SPICE_t.th
I%FIi|:|Chi|:u:kg_l‘Ii|:u:hi|:_E-_TabIeCu:nntent
ibis _Flipchip_plg_flipchip_g.plg
: ibis_FIipchipJ:ukg_FIipchip_Eu:nin.ibs
‘;'.‘g & pka_Flipchip_6

by Documents

Result_FIi|:Chi|:u:nl=
Rnasult_FIi|:C|'|i|:|J:|Ic
Result_F|i|:lZZhi|:u:||=
Result_FIi|:lZZhi|:u:||=
Rnasult_FIi|:C|'|i|:|J:|Ic
Result_F|i|:lZZhi|:u:||=
Result_F|i|:lZZhi|:u:||=
Rnasult_FIi|:C|'|i|:|J:|Ic
Result_F|i|:lZZhi|:u:||=
Result_F|i|:lZZhi|:u:||=
Rnasult_LI|'|titI|3|:IJ:|Ic
B Untitled_pkg_flipch
B Untitled_pkg_flipch
[e=h Untitted_pkg_Fflipet

. E’l ResourceProfile_xtractIM I%LInI:iI:Ich:-k.g_FIh:-d
My Computer
< >
‘L_‘] File name: Fie:z:ul | - | I Save |
" 1 et
MyMetwork  Saveastype |4l File (%) - | Cancel |

2. Enter a file name.

3. Click on Save. The results are saved in a binary file named as result and

result_spd_file_name.xim

4. Click on Cancel if you do not want to save the results in the file name you entered.

Output Files

The SPICE file and two IBIS files are automatically saved by the tool. The result file is only if the user
chooses to save. The result and result*.xim files save all the output data including:

»  SPICE circuit
*  Summary
*  Two package model files.

The output files on hard disk include:

*  One IBIS Package Model File — *.pkg file. Both L and C include coupling elements.

*  One Pin Model in Excel Format — *.csv file. Including each signal net length, self-R, self-L,

self-C, and time delay. No coupling elements are included.

e One Pin Model in IBIS Fomat — *.ibs file. Including self-R, self-L and self-C for each signal

net. No coupling element is included.

¢ One Summary Content in Excel Format — *.csv file. Including RLC Full Matrix.

e Three Segment RLC in Excel Format — Segment RLC of each metal layer with *.csv files.

*  Two SPICE Circuit Files — Pi-model named *.ckt and T-model named *_t.ckt.
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Load in Saved Results

Saved results can be loaded by selecting Load Results in the workflow pane.

* Loaded Curves — Shows the loaded results.
e Main window — Shows the selected result.
*  Present Curves — Present extraced results.

Choose to view present results or the loaded results. A loaded result can be unloaded by clicking on
the Unload Extractor Result icon in the toolbar. The Load and Unload Result buttons are indicated.

Sptractit - FlipChip.xml - [Resistance]

& Workspace Window

0 H-

Wigw

IR BRI =

Help

%

i|C:'LSiuritvSamnles'tSDeedF| ‘|t@ o B )

B|le p

Workflow: kractIi

x

|Se|F Terms | et |Resistance | T |

Default

i

- I&]x]

ol

Present Curves

@

Manage Workspace

Load Workspace
Load a Mew/Different Layout

®

Package Setup

Circuits
Stackup
Burips
Solder Ball
MNets

A

®

Simulation Setup

Module: IBIS/RLGC
Simulation Type: Met-Based

®

View/Export Results

Surmrmary
SPICEJIEIS Model
RLZ Per Met

RLC Distributions
Seqgrent RLC

RLC ws. Met Length
CrossTalk

Save Resulks

Load Results

Self Terms

i5elf)

Mutual Terms

Resistance (Ohm) Extractor Result

T T
| |
| |
| |
241NN SN SSSS S
| |
i i
| |
|

025 4+ H-pp——= - - - —=

|
|
:
|
0.2 +-fr-g4kd
|
|
|
|
i

015 -~ -~~~

Loaded Curves

Self Terms

::Result_FIipChipJ:kg_FIipchipH
Mutual Terms

I M.

<«

Ver: 4.1.3.02141 (51i54)

]
]
]
|
|
I
T
|
|
i
0054 —--===rr—mmm == dgmmem-o-
!
I
|
|

e
=

Tt

——3Self
(Self)

e =

|

Mouse(mm): ¥: -15.127, ¥: 12,805

(@ Ready

BATCH MODE SIMULATION

To run a simulation in Batch Mode, follow these steps.

1.

Click
Start -> Run
Change to the directory where the XtractIM.exe file is located.
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Batch Mode Example

If you want to use the project (.spd file) defaulted in the workspace file (.ximx file), enter:
ExtralM -b “Full_path_toMy workspace_File\workspace filename”

If you want to use a different project file other than the one in the .xml file, enter:

ExtralM -b “Full_path_toMy workspace_File\workspace filename”

“Full_path_toMy_workspace_File\new_spd-filename”
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Saved Output Files

Upon completing the simulation, all output files are saved automatically in the same directory as the
* spd file. Saved files include:

o *ckt
o *csv
e *ibs
+  *pkg

Package Setup

XtractIM can handle both flip-chip packages and wirebond packages with 3D bonding wire profiles.
It can extract models of full packages or selected nets of a package.

Open the XtractIM main window. There are only two icons available: New and Open.

* Newicon — Creates a new workspace.
*  Openicon — Allows users to load an existing workspace file.

You’ll setup the following items to prepare for a simulation.
1. Select a package type: wirebond or flip-chip.

Set the C4 Bump data if it is a flip-chip package.

Set the Solder Ball data.

Setup the circuits.

Select or deselect Die-circuit and Board circuit.

Setup the Stackup.

Set parameters for the C4 Bump and Solderball medium layer.

© N o o W N

Select the nets for extraction.

There are four options to define the extraction frequency and extraction result output.

*  Set Extraction Frequency.

*  Set Mutual Capacitance Output Filter Factor.
*  Set Mutual Inductance Output Filter Factor.
*  Set Strongest Coupling Neighbors.
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Chapter

XtractiM Simulation of a Stacked BGA Package

This chapter takes you through the steps to use the XtractIM tool in the simulation of a
stacked BGA Package.

SIMULATION SETUP

A typical workflow in interaction mode includes the following steps.

Create a new workspace file or load an existing file (.ximx file).

Open a layout file (.spd file).

Select a package type: wirebond or flip-chip, single BGA or stacked BGA.
Set up the circuits: select or deselect Die-circuit and Board circuit.

Set up the Stackup: set parameters for the C4 Bump/Solderball medium layer.
Set the Bump data if it is a flip-chip package.

Set the Solder Ball data.

Select the nets for extraction.

Setup extraction frequency and capacitance / inductance output control.
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Setup the Package Simulation

1. Start in the Workspace.
2. Open the XtractIM main window.

There are only two icons available: New and Open.

The new icon creates a new workspace.

The open icon allows users to load an existing workspace file.
3. Select appropriate icon (new J or open =} ). Click.
4. To create a new workspace, click on the New icon;

or select

Workspace > New

apXtractibd - Untitled - [Untitled Layer Wiew]

~& ‘Workspace Edit Wiga Setup Tools Window Help

R PSR 3 [ :|Extractor Result ~ |3 B -l_;
! B Q@@ E: A &l
all Enabled Net{s) @ — A ok e =W TR Ky
“ ® @ B & 0B+ [F 4 MRS ol N
‘WorkFlow: brackIM * 1 l-SDI |-4DI |—30 |-20 |-1DI lD . |1D . |20 |30 |4D . ISU
Default A E
— o=
Manage ¥orkspace (&) =3
Load Workspace _3
Load a Mews/Different Layout a E|
Package Setup (~) E
Package Type: Wirehond &:
A Circuits E
A Stackop Wi
% Solder Bal i
" Mets E
Simulation Setup (~)

Module: IBIS/RLGC
Simulation Type: Met-Based

View/Export Results '{‘,"

Surnmary
SPICEJIBIS Model
RLC Per Met

RLC Distributions
Segrment RLC

RLZ ws. Met Length
CrossTalk

Load Resulks

Wer: 4.1.3.02141 (5IG4) Mouseimm): ¥: -50.204, ¥ -52,403 .a Ready

5. To load the Package Structure, click on
Load a New / Different Layout

e »

Laver Selection

Plane0z
Planed1
Signalol

¢|i¢][¢)i¢

x

O/0|(m|m

vl Wiew Only Active Layer

Display Geometry Objecks By

*) Mek Color

x| P ||=

Layer Selection

Laver Calar

i/~ /e/FRs
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The Attach Layout File window opens.

Attach Layout File

Apply current workspace setup

Please choose the bype of lavout to load
*) Load an existing SPD File

Load an existing DF File

[uls Cancel

Select Package Type
1. Select a Package Type.
The package type settings are displayed in the Editor pane.
The example show a package type that is
Single Die, Stacked BGA, Flip-Chip

Package Setup () mf W Sigr
iPackage Type: Flip-Chip | =l - | Sigr
& Circuits =|f| [ Sigr
" Stackup = s Cinr
" Bumps __' | Wigw
" Solder Ball -
o Mets . Lisplar,
Simulation Setup () . LE & et
Madule: IBIS/RLGC -
. . . _ 1 [ |
Simulation Type: Met Bas_ed E ﬁ\ﬂ E
i (L] L=
View/Export Results ) Layer ¢
CLirmrnars
Package Setup - = Package Twpe
*) Single Die Stacked Die Side-by-side Die
Single BiaA *) Stacked BGA Leadframe
Wiirebond *) Flip-Chip Binth
Cancel
Wer: 4,1,3.02141 {SIia4) Mousefmm): ¥ -11.965, ¥ 4,776 .a Ready
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2. Click OK to save your selection.

3. Click Cancel if you want to change your selection, start over or cancel your session.
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Setup Circuits

1. Click on Circuits in the Workflow pane to setup the Circuits data for a Flip-Chip package. A
new pane opens up in the left side of the workspace.

- ‘v.
Select the Digf/Component circuit From the lisk and click Mext
Zkk Mame ZkE Model Die/Board)Compa...
POPEop POP_top Board
POPbotkom POP_bot Board
Diel DieZ2 Die
o Cap0402
7 Cap0402
s} Cap0402
5 Cap0402
4 Cap0402
3 Cap0402
2 Cap0402
1 Cap0402
h, "
2. Right-click on the desired circuit.
. 5
Select the Die/Component circuit From the lisk and click Mext
Ckt Marne CkE Model Die/Board/Compa. . .
POPEOp POP_top Board
POPbaoktom POP_bot Board
Diel Die2 Die
g Cap0402
7 Cap0402
05 Cap Select as Die circuit
4 Cap
L] Cap . _
2 Cap Select as Capacitor circuit
1 Cap
n "

3. Select it as a Die circuit.

4. Click Next.
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5. Right-click on another desired circuit.

6. Select it as a Board circuit.

7. Setup the second Board circuits.

8. Click Finish to finish the setup.
Setup Stackup

1. Click on Stackup. The Stackup window opens.
2. Right-click on the Signal$Bottom layer.

-
Layer Manager -» Stack Up 0O x
Stack Up |
Layer # Color Layer Icon | Lawer Mame Thickness{mm) Material Conductivity{Sfm) Permittivity | Loss Tangent | Fill-in Dielect
1 0 Signald3 0005 et 007
) Burnp01 B
z Signalfl3aec4D7?... 0.015 1.51429=+006
Medium$136C4... 0,125
3 Signal$136C4DF... 0.015 1.81429%9=4+006
Medium$136C4... 0,125
4 Signal$136C4E7.., 0.02 1.8142%e+006

Medium$12F371.,, 0,125

=

Insett Above ¥

Insert Under Signal Layer
Delete Mediurm Laver

Plane Layer

Solderball Medium Laver, Signaldl Layer, and Mediurm0l Layer POPbotton
POPEop

| Il |
Limit: Tokal Thickness:  5,4500e-001 mm | View Material || Irnpork: |

Solder Eall Laver Bump Layer

| Ok || Cancel |

For a PCB medium layer you can insert:

* A Solder Ball Medium Layer
*  Anempty signal layer
* A medium layer standing

All layers are inserted under Signal$Bottom. The added signal layer is located at the end of the
solder ball.
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Setup Bumps

The example shows the setup for a Flip-chip package.

1. Click on Bumps in the Workflow pane. A new window opens up in the Editor pane.

Package Setup -= Burnps

I—
Layver MName Circuit Mame Dmnaz () D1 Cmm) D2 () HT {rnm}) Conduckivity {5/ m)
Bump0O1 1 0.116727 0116727 0.116727 0.1 5.8e7 B
4+— Dmax —»
H—D2—M
Ok, || Cancel |
Ver: 4,1.3.02141 {SIG4) Mouse(mm): ¥: -15.76, ¥ 12,594

2. Input the settings for the C4 Bumps.

Maximum Diameter: Dmax (mm)
D1 (mm)

D2 (mm)

Height: HT (mm)

Conductivity (S/m)

3. Click OK to save your entries or click Cancel if you do not want to save your changes.

XTRACTIM SIMULATION OF A STACKED BGA PACKAGE 65



Simulation Setup XtractlM User’s Guide 16.6

Setup Solder Ball

1. Click Solder Ball in the Workflow pane. A new pane opens up in the Editor pane.

Package Setup - > Solder Ball

Layer Mame Circuit Mame Dmax {mm) | D1 {mm}) D2 {mm}) HT {mm}) Conductivity (5/m) Medium Thickness {mm})
Solderballol POPBottam 0.397115 0.397115 0.397115 0.5 5.8e7 0.05
Solderballoz PCOPEop 0.397115 0.397115 0.397115 0.65929 5.8e7 0.05

Medium Thickness

Cancel

Wer: 4,1.2.12213 (SHCME) Q Mouse(mm): ¥ -12.206, ¥: 0.627 O Ready

2. Input the settings for each Solder Ball.

Maximum Diameter: Dmax (mm)
D1 (mm)

D2 (mm)

Height: HT (mm)

Conductivity (S/m)

Medium Thickness

3. Click OK to save your entries.

Click Cancel if you do not want to save your changes.

NOTE  Set up two solder balls for each stacked BGA package.

Setup Nets
1. Click on Nets in the workflow window. The Net Manager window opens.
2. Choose any desired nets for RLC extraction.
Users can also move the signal net into and out of PowerNets and Ground Nets.

* At least one Ground Net must be selected to act as a reference ground net.
*  Only choose the desired Ground Net as the reference ground net.
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[ Net Manager x|
Net: | =
|Defau|t Mode | - |
Met List (Sort enabled first) * | Interface

2 unnamed Met{s)
= B8 PowerMets
B8 vDDcore
Evoo_1 =
Evoo 2
~vDD_3
Eivoo 4
= 24 Groundiets Bl
B vss
= ZADEFAILT
Binet 1
Elnet_ 2
EMet_3
Elnet_4
ElmMet_5
Enet_s
EMet_7
EnMet_s
Elmet_o
Einet_12
Eret_13
Eliret_14
Bl Met_15
Bl ret_15
Elinet_17
Bl ret_19
LMet_21
Bl ret_23
Biiret_24
[ — T |
eneral
Keep shape enabled when the net is disablec
["1Hide Disabled
Gray Disabled

Layer Selection  Met Manager

3. To set up Rise Time and %Coupling for identfying coupled Trace, click
Auto Coupled Line

XTRACTIM SIMULATION OF A STACKED BGA PACKAGE 67



Simulation Setup

XtractlM User’s Guide 16.6

| Met Manager

Met:

x|
=
- p-

| Show Coupled Line

|v|

|I_I

-
1

4

Met List (Sort enabled first) -~

Hunnamed Net(s)
=l B8 PowerMets
B8 vDDcore
EvoD_1 100
EfvoD_2
AvDD_3
BEvDD_4
=l H GroundMets
1 B vss 100

= ZA DEFAULT

Enable Selected MNets
Disable Selected Nets
Enable All MNets
Disable All Nets

Edit Coupling Parameters
Delete Coupling Parameters
Set With Default Parameters

Classify
Detect Associated Mets

Mew
Delete
Rename
Import...

Merge Selected Mets
Split Open Mets

3D View Walk Through
Property

" Rise Time (p:

disabled

T T e T T T [ LT L T TR )

¢
[ |
Coupled Lines Report

4.
5.

La rer Selection | Net Manager

Select the nets you wish to edit.

Right-click to open the pop-menu.
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| Met Manager

Met: |

| Show Coupled Line

|v|

[

< ¢

-
||
|

Met List (Sort enabled first)

2 unnamed Met(s)
=l B rowerhets

=

Ef vDDcore
BElvDD_1 100
B voD_ 2
~]vDD_3
B voo_4
= 24 Groundiets
B§ vss 100
ZADEFALLT

Enable Selected MNets
Disable Selected MNets
Enable All Nets
Disable All Mets

Edit Coupling Parameters
Delete Coupling Parameters
Set With Default Parameters

Classify
Detect Associated Nets

MNewy
Delete
Rename
Import...

Merge Selected Mets
Split Open Mets

30 View Walk Through
Property

" Rise Time (o

dizablec

¢
] crmamie coapreo cine s oo
L

oupled Lines Report

x|
=
- A

6. Select

Set With Default Parameters

7. Click

Net Manager > Coupled Lines > Show Auto Coupled Lines

The Trace identified as coupled lines appear.

La rer Selection | Met Manager
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EXTRACTION FREQUENCY AND CAPACITANCE / INDUCTANCE OUTPUT CONTROL

You can change the extraction frequency. The default value is 30MHz. Use the window shown in the
example to change the default value. Follow these steps:

1. Select

Setup > Frequency of Extraction

2. Update the data in the pop-up window.

Set Output Factors

XtractIM captures all the coupling during the extraction stage. It has options to reduce the size of the
output circuit during the export stage.

1. Open
Setup > Threshold for Exporting Coupling Terms

A pop-up window opens.

Threshold for Exporting Coupling Terms »

Mumber of strongest neighbors ko expart

In addition,

Ignore mutual C iF the ratio of mutual over self kerms is less than (0,005

Ignore mutual L if the ratio of mutual over self terms is less than |0.005

Ok | | Cancel |

2. Choose the number of strongest coupling neighbors to be kept in the circuit model. In addition,
ignore mutual capacitance or inductance if the ratio of mutual terms over self term is less than a
percentage.

The default on number of strongest coupling neighbors is 10; which means
Only outputting the 10 strongest neighbors (including self)
The default percentage threshold for ignoring mutual capacitance /inductance is 0.005; which means

If the mutual capacitance or inductance is less than the 0.5% of the minimum of the two
self-capacitances / inductances,

XtractIM will not output the mutual capacitanceor inductance.
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Save Workspace and Layout File

You can see the save and open icons on the toolbar menu.

' Extractib - POP_wirebond. xml - [pop_wirebond.spd Laver Wiew]

& Weorkspace  Edit Wiew  Setup Tools  Window  Help

G @ EExtrac

ARE-A" RANITE 3 B =R =2 R IR R
I I
Open {Cirl + O) Attach a Layout File
Save All

Save Workspace File

Method 1
Select
Workspace > Save As

The Save Workspace File dialog opens.

Save Warkspace File

T X
Savein: | [ Stacked-BG&_Sample_files | - | €] 1‘ o v
Ty | PoP_flipchip
i 2; |= PoP_flipchip-1
My Recent |2 POP_wirebond
Documents
€
Dezktop
ty Documents
by Computer
‘g File name: | | - | | Save |
Fly M etwark, Save az type: | Eutractor Workspace XML Files [* xml) | - | Cancel
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Method 2

Clickon " next to the Save = button, select Save Workspace File from the drop-down menu.

H' il . I

Save Workspace File

Save Layouk File

Save Layout File

Clickon 7 next to the Save i button, select Save Layout File from the drop-down menu.

Lﬂ' A d I

Save Workspace File

Save Layout File
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RUN THE SIMULATION

Click on the Play button at the top of the window to start the extraction (simulation).

XtractIM only extracts RLCG for the net which has at least one pin at the Die-side and at least one pin

at the board side. At the beginning of the simulation, if some nets have Die-Board mis-match, a pop-
up window asks you to select the next action.

Continue — Continue the simulation.

More Information — Examine what nets are mis-matched.
*  Stop — Cancel the simulation.

The More Information window lists all the mis-matched nets. You can investigate them to see wheth-

er it is a special design or a defective design. You can then decide whether or not to proceed with the
simulation.

Choose Continue, Stop or More Information. If 30 seconds
NOTE pass and the user has not made a choice, by default, the simu-
lation continues.

OBSERVE AND SAVE SIMULATION RESULTS

XtractIM calculates each net’s resistance, self loop inductance, conductance, and self capacitance as
well as its mutual loop inductance and mutual capacitance with other nets.

The inductance and capacitance are matrices. For example, a simple group of four nets has the follow-
ing inductance and capacitance matrix.

_Lll Ly, L, L, ] Cy Cp G5 Cy
Ly Ly, Ly Ly, Cy Gy G Gy
Ly Ly, Ly Ly, Gy Gy G G,
_L41 L4’J L43 L44_ _CH CJJ CS CJ-L_

In the Inductance Matrix, the Diagonal Element is the Self Inductance of each net, and the off-diagonal
elements are mutual Inductance.

There are two concepts of capacitance matrix: Maxwell capacitance matrix and SPICE capacitance
matrix.

Maxwell Capacitance Matrix — Each diagonal element is the loading capacitance (for exam-
ple, capacitance to ground when other nets are grounded which represents the worst-case
capacitive loading). Off-diagonal elements are mutual capacitance with negative values.

SPICE Capacitance Matrix — Each diagonal element is capacitance to ground. Off-diagonal
elements are mutual capacitance with positive values.

The relationship between Maxwell capacitance and SPICE capacitance matrix is shown below.
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C,(SPICE) =-C ,(Maxwell )

C, (Maxwell )= C, (SPICE )
j

C,(SPICE) = Z C; (Maxwell )
j

In RLC Per Net view, there are two options:

*  Mutual Term View — Mutual inductance or SPICE mutual capacitance.

*  Self-Term View — Resistance, self-inductance or Maxwell diagonal capacitance.
You can choose to view resistance, self-inductance, self-capacitance for each net.

You can also view mutual terms if inductance and capacitance are desired. Usually conductance is very
low, so there is no view for conductance.

Display Results

Upon finishing the simulation, the defaulted result display is a SPICE model.

spstractib - POP_wirebond . xml - [Circuit Topology Result] _ O %
wF File  Window  Help &[]
IJEQ' I | EE 4 ( F ::DDEExtractorResult v'@‘@%%_?—:‘[} @ p
iorkflow: sEractIi ¥ | Extractor Hesult |
Default 23
Manage Workspace @ —iew Model Selectio
Load Workspace ) SPICE T-model
Load a Mew/Different Layout CYDC_F of Each Path
Package Setup @ -
Package Type: Wirebond OPRLC of Each Path
" Circuits () Coupling of E ach Path
" Stackup

o Mets
Simulation Setup @
Module: IBIS/RLGC .SUBCET POP_w1r?b0ndfpop_w1rebDnd_NetBaseSPICE é'
Simulation Type: Net-Based + Diel Diel-12 POPtop_ POPtop-C1
~ @ + POPhottom POPhottom-C1
View/Export Results + Diel Diel-135 POPtop POPtop-A3
SUrnrmary + FOFPhottom FOFhottom—Ai3
SPICE Model + Diel Diel-S& FPOPrLop FPOPLOp-C12
Eranch RL + FOFbottom FPOFbottom—C1Z
Save Results + Diel Diel-51 FOFProp FOFTOp-M3 -
Load Resulks q m N
Customize Workflow ¥
Cukpuk =
Completing Trace Circuits Y

Creating Coupled Trace circuits

Preparing Medium for Simulation

Preparing Boundary Condition

Compuking Edge Reflection Coefficient. ..
* Processing Patchoz -- Patchol

Connecting Circuits To Patches

Handling Flaating Circuits

Maodeling Pads

Solving Package and Circuits L.,

Simulation is in progress,

Miscellaneous | =< - Errors | Variablestheck |

Wer: 4.1.2. 12215 (SHCNS) & Mouseimm: ¥: -8.161, ¥: 12.735 o Ready

<[]

XTRACTIM SIMULATION OF A STACKED BGA PACKAGE 74



Observe and Save Simulation Results XtractiM User’s Guide 16.6

Circuit Topology

The circuit topology for stacked-BGA is shown in the following illustration. Here we see one net and
three branches for Die, BGA1 and BGA2.

L _bgal

R die L_die
R bgal [ pga2

Display Results Example
1. Click on
RLC of Each Path
2. Click to view the Net Length, DC R, Self R, Self L, Self C, or Delay of a Signal Net.

In the example, these path names are used for each of the three paths. The actual Die or BGA circuit
name is given to describe each of the three paths.

Die-toBGA1 — U1 ::: POPtop
Die-toBGA2 — U1 ::: POPbottom
BGA1-toBGA2 — POPtop ::: POPbottom
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Extractor Results Display

Sextract b4 - POP_wirebond. xrl - [Circoit Topology Result]

Manage Workspace @

Load Workspace
Load & Mew/DifFerent Layouk

Package Setup @
Package Type: Wirebond
" Circuits

" Stackyy

1%
Simulation Setup @
Module: IBIS/RLGC

Simulation Type: MNet-Based
View/Export Results @
Sumrnary
SPICE Maodel
EBranch RL
Save Resulks
Load Results

Customize Workflow

ver: 4.1.2.12213 (SHCNB)

3 SPICE T-model
(O DC_R of Each Path
83 ALC of Each Path

) Coupling of Each Path

—Wiew Model Selectionr——————

POPtop -» POPbaottom

e
‘> File \Window Help IZI
o L = | & | 9 e 10 | Estractor Result MALERER, =) % a3 I:'?b @ b
WorkFlow: xkrackIM > | Esztractor Result |
Default 2

SighalMetM ame Metl engthmm] SelfR [Ohm] SelfL[nH] SelfC[pF] Delay[pS] -
WDD_1 0,301 246 0775691 26748 144042
WDD_2 0.2E5562 0.748615 273953 143.198
WDD_3 0.302849 0.776596 26.6997 143.996
WDD_4 0.282386 0.76083 26.9447 143179
YD Deoore 0186617 0.535258 30.0466 126.818
Met_3 779192 492455 4 83887 1.40485 82 4503
Met_4 6.60578 425473 420256 1.16228 698897
Met_5 6.10994 401643 3.96558 111625 66.5326
Met_& 6.52319 420973 415718 1.15524 69,3004
Met_2 10,1583 BA7106 5. 97233 1.50005 94 6522
Met_3 113106 EB1326 6.52607 1.E61078 102527
Met_10 11.8657 E.7E987 6.81493 1.EE19 106.423 -
2ukpuk *
Completing Trace Circuits -
Creating Coupled Trace circuits
Preparing Medium For Simulation
Preparing Boundary Condition
Zomputing Edge Reflection Coefficient. ..
* Processing Patchi02 -- Patchol
Connecting Circuits To Patches
Handling Floating Circuits
Modeling Pads
Solving Package and Circuits ... @
Simulation is in progress.
-
Miscellaneous | Mesh - Errors | VariablesCheck |
Ay Mouse(mm): ®: -8.161, ¥: 12,735 @ Ready
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Summary of the Extracted Results

Click on Summary to open the brief summary about the extracted R, L, and C. It shows the maximum
(Max) and minimum (Min) values and other information.

A typical Summary display is shown below.

Spxtractit - POP_wirebond, xml - [Suramarny]

Module: IBIS/RLGC
Simulation Type: Met-Based

View/Export Results @
Surmary.

SPICE I\'J

Qpen the window b0 view summary. I

Branch AT
Save Resulks
Load Results

Y |

Wer: 4,1.2,12213 (SHCNE)

- 0 x
1} File  ‘Window  Help E
._‘]ﬁﬂv “b_d. Eﬁ i ;ExtractorResult "@ @%ﬁ L_‘ﬁ 2 b
Workflow: BtractIM Extractor Result
Default 2| [Version] 4.1.2.12213
- [Date] 0z/15/2011
~
Manage Workspace (%) [Package Nawe] €\ SigricySamples\SpeedPKG 4. 1%XrractIM Samples)Stacked-BGA S
Load Workspace [Description] C:hSigritySamples) SpeedPEG 4. 1\XtractIM) Samples)Stacked-BGA £
Load a Mew/Different Lawouk [Hets Extracted] 55
Package Setup @ [Fregquency of ExXtraction] 30MH=z
Package Type: Wirebond [Max R {mOhm)] 5410.33
o Circuits [Min E (k) ] 24,8305
o Stackup [Max self-inductance LinH)] 5.0459z2
o [Min self-inductance LinH)] 0,204955
o :Hets [Max =self-capacitance C({pF)] 30.0466
P [Min self-capacitance C(pF)] 1.11625
Simulation Setup @

Cubpuk

Completing Trace Circuits
Creating Coupled Trace circuits
Preparing Mediurn For Simulation
Preparing Boundary Condition

Computing Edge Reflection Coefficient. ..

* Processing Patch0Z -- Patchol

Connecting Circuits To Pakches
Handling Floating Circuits
Modeling Pads

Salving Package and Circuits ...

Sirulation is in progress.

Miscellaneous

AN Mauselmm): & -8.161, ¥: 12,735

@ Ready
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Brand RL and Total C

Click Branch RL to open up a .csv file and display the branch R, L, and C of each net.

If a branch is missing from a net, the cells are left empty.

‘k File  Window  Help

QE H- >
‘it kflow: HerackIM
Default

Manage Workspace ]

Load Workspace
Load a Mew/Different Layout

Package Setup '.‘:‘)
Package Type: Wirebond
" Circuits
" Stackyy
" Mets
Simulation Setup )

Maodule: IBIS/RLGC

Simulation Type: Met-Based
View/Export Results  (~)

Summary

SPICE Model

Branch RL

Save Resulks

Load Results

Yer: 4.1,2,12213 {SHCNE)

Save Results

Sextractiy - POP_wirebond, xml - [Branch RL Result]

=
X | Extractor Result

Extractor Result

MEERER SRHIE E-

Met Mame C-tatal [pF] Fi Die1[0hm) F POPtop(Ohm] F POPbattom(0... | L Diel[nH]
YDD_1 26.748 0.270805 0.027912 0.0251335 0.525405
wDD_2 27.3953 0.234721 0.0288817 0.025519 0.497138
VDD_3 26.6997 0.272649 0.028121 0.0248305 0.526889
YwDD_4 26.9447 0251421 0.0290218 0.0286632 0.508934
YD Dcore 30.0466 0135419 0.0504598 0.0430484 0.225419
Met_3 1.40488 441619 0.665091 0.783387 3.99476
Met_4 1.16228 386269 0.386106 0386296 346211
Met_5 1.11625 367821 0.332636 0.33453 3.28026
Met_B 1.15524 3.82645 0.377005 0.37686 3.42854
Met_8 1.50009 4.39303 1.07748 0.65526 4.00454
Met_9 1.61075 4.76581 1.27276 0779166 439264
Met_10 1.6619 5.36024 1.28154 1.0528 499519
Met_11 1.48602 4.7483 0.733669 0.96347 440896
Met_14 1.61707 4.70061 1.30459 0.760055 4.3062
Met_16 1.34963 4.38604 0.562134 0.721594 4.0274
Met_22 1.62869 483354 1.30514 0.803443 4. 46348
Met_25 1.63535 4.82982 0.894715 1.21656 4.43345
Met_26 1.72337 533217 1.33126 1.09529 493932
Met_29 1.22406 406227 0.468012 0.467184 3.67226
Met_32 1.2758 3.85571 0.674777 0.457732 345881
Met_33 1.66076 4.75275 1.29399 0.785142 4.34833
Met_35 1.35651 455583 0.67165 (0.6E5505 417161

- Met_38 1.16016 3.83255 0.384784 0.384587 3438
v Met_39 1.36341 453493 0.683428 0677411 420605

Met_40 1.50452 4.4288 1.08353 0.BE1726 403756
Met_45 1.15811 3.83758 0.380752 0.380407 3.43912
Met_46 1.28821 4.33734 0.564761 0561182 3.94382
Met_47 1.12862 3.71556 0.346689 0347215 3.323n
Met_48 1.22499 4.05743 0.469919 0.463022 3.66882
Met_50 1.11707 369161 0.331052 0331842 3.29201
Met_51 1.12769 372152 0.346351 0247255 3.3244
Met_53 1.23698 41107 0.486221 0.485359 3.71975
Met_Bd4 1.13227 373696 0.350212 0350834 334174
Met_55 1.28716 4.34203 0.562411 0.558506 3.94604
Met_BE 1.2007 4.02094 0.436802 0.436177 3.62003
Met_E1 1.25699 417884 0.516009 0.515342 3.79051
Met_E2 1.35094 451639 0.662345 0.657402 413345

[ il
M\ Mause(mm): ¥: 8,161, ¥: 12,735 @ Ready

In the Workflow pane under View/Export Results, select

Save Results

The Save Extractor Result window appears.

L POPtop[nH]
0.244054
0.247703
0. 245555
0.24E8386
0307221
1.05829
0.780797
0.728336
0.76934
1.48275
1.67807
1.71493
1.10822
1.7341
0.94495
1.71253
1.28396
1.74835
0.883643
1.05847
1.67938
1.07761
0.775592
1.09126
1.43004
0.773939
096103
0.743508
0.834014
0.730968
0.744237
0.903089
0755183
0.958274
0.834067
0.936123
1.06E876
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[ N
Save Extractor Result As

b

Savein; |_} Stacked-BGA,_Sample_files |v| € ¥ o E-

5 Ej ZPU_InFo @ *kractIMRunTimeErrar
L9 % oop fipchio
My Recent = PoP_flipchip
Documents | | | poP_flipchip-1
e <& pop_wirebond
E| POP_wirebond
Desktop @POP_wirel:u:nndJ:Dp_wirel:u:nnd_CouplingDFEachPath
@POP_wirel:u:nndJ:Dp_wirebond_DCResistance
F‘OP_wirel:u:undJ:np_wirehund_NetBaseSF‘ICE.u:kl:
_.-—) @POP_WirEbDndep_wirEbDnd_RLCDFEaEhPath
@POP_wirehand _pop_wirebond_TableEranchRL
r;j ResourceProfile_ykractIM
Resu|I:_F‘OP_wirebundjup_wirebund_DZ1511_141319
:!j'j ResuII:_F‘OP_wirebnndjnp_wirebnnd_l02610_095156

E] “rracked_Pintode_Info
kA Computer

| | B
"-‘_-‘] File name: FIE:s:uI | - | I Save I
-
My Netwark, Save as type: |,-’.\|| File [7.7) | - | ! Cancel

2. Enter a file name

3. Click on Save. The results are saved in a binary file named Result.

4. Click on Cancel if you do not want to save the results in the file name you entered.

Output Files
The result and result*.xim files save all the output data The output files on hard disk include:
*  One SPICE Circuit File — Named *.ckt.

*  RLC of Each Path File — An .xIs file including each Signal Net’s Name, Length, DC R, Self
R, Self L, Self C and Delay.

* Branch RL File — An .csv file including the branch R, L, and total C of each net.
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Load in Saved Results

Saved results can be loaded by selecting

Load Results

-
Load Extractor Result(s) From ? x

Loak in: | [ Stacked BG&_Sample_files

|'| « N Wl

Y Ej CPU_Info Ej *kractIMRunTimeErrar
" :3 @pnp_ﬂipchip
My Recent | PoP_flipchip
D ocuments

|2 PoP_flipchip-1
= xé’-'pup_wireband
L | = POP_wirebond
@POP_wireboru:IJ:D|:|_wirebond_CoupIingDFEachPath
@POP_wireboru:IJ:Dp_wirebond_DCResistance
POP_wireboru:ljnp_wirebu:und_NetBaseSPICE.ckt
%]POP_wireI:n0ndjDp_wireband_RLCDFEachPath
@POP_wireh0nl:IJ:Dp_wirehand_TabIeBranchRL

E] ResourceProfile_XkractIM
Result_POP_wirebond_pop_wirebond_D21511_141319
’jl;g =]l Result_Por_wirebond_pop_wirebond_102610_095158

EJ stracked_Pintode_Info

Desktop

7,

iy Documents

iy Compuiter
& | ?
q File: narne: |F|esu|t_F‘D P_wirebond_pop_wirebond_102E1 D_| - | | Open |
My Metwork | Files of type: |l File .7 - Cancel

Choose to view present results or the loaded results.

To unload a loaded result, click on the Unload Extractor Result Icon.

BBy
———Unload extractor result b

BATCH MODE SIMULATION
To run a simulation in Batch Mode, follow these steps.
1. Click
Start -> Run

2. Change to the directory where the XtractIM.exe file is located.
Example

If you want to use the project (.spd file) defaulted in the workspace file (.ximx file), enter:

ExtralM -b “Full_path_toMy workspace_File\workspace filename”

If you want to use a different project file other than the one in the .xml file, enter:
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ExtralM -b “Full_path_toMy_workspace_File\workspace filename”

“Full_path_toMy_workspace_File\new_spd-filename”

Saved Output Files

Upon completing the simulation, all output files, including *.x1s and .csv files are saved automatically
in the same directory as the *.spd file.
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XtractiM Pin-Based Simulation of a BGA Package

This chapter takes you through the steps to use the XtractIM tool in the simulation of a BGA package
with pin-based Extraction.

SIMULATION SETUP

A typical workflow in interaction mode is the same as net-base extraction.

Single-BGA Package

A qualified net is the one which has at least one pin in each of the die- and BGA- circuits. In addition,
no open circuit exists for these pairs of pins.

Stacked-BGA Package

A qualified net is the one which has at least one pin in each of the die-, BGA-top, and BGA-bottom
circuits. In addition, no open circuit exists for these three pins.

XtractIM automatically checks to see if a net is qualified to be a reference net.

Setup Simulation Type

The Simulation Setup options are located in the menu bar on the left side of the window.
1. Click
Simulation Type
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Simulation Setup -> Simulation Type

Model Extraction

* NetBased () Pin-Based

oK || Cancel

2,

Select

Pin-based

Simulation Setup -> Simulation Type

Model Extraction
ONet-Based  (#) Pin-Based

Ca

ort Reference

Layer Circuit Name Circuit Model ) Use Reference Net
e
= se Reference Node(au
Signal$136C4EFOM4 | POPbottom POP_bot
Signal$13sC4D70M1 | POPtop POP_top ) Use Reference Node({manual)

|
(#) Use Reference Element |Blement ID:
Pin Groups: X [

3. Inthe Reference Net field, all qualified reference nets are displayed in a list.
4. Select Reference Net for each layer.
—Port Reference
{2 Use Reference Met
Feference Met:
{#) Use Reference Modelauto)
W35 -
_ ) Use Reference Modelmanual)
T
) Use Reference Element
RS
B Ready
5. Select a ground net as the reference net for a pin-based simulation.
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Setup Extraction Frequency

1. To change the extraction frequency, select

Setup > Extraction Frequency

Extraction Frequency »

Extraction Frequency: a0 MHz "

2. Update the data in the pop-up window.
3. Use the Threshold for Exporting Coupling Terms window to change the default value.
The default value is 30MHz.

Setup Threshold for Exporting Mutual Terms

Use the XtractIM options to reduce the size of the output circuit during the export stage.
XtractIM captures all the coupling during the extraction stage.
1. Open

Setup > Threshold for Exporting Coupling Terms

A pop-up window opens.

rThreshcnll:l for Exporting Coupling Terms x

Mumber of strongest neighbors to export

In addition,

Ignore mutual C i the ratio of mutual over self terms is less than |0.005

Ignore mutual L if the ratio of mutual over self kerms is less than |0.005

Ik | | Cancel |

2. Choose the number of strongest coupling neighbors to be kept in the circuit model.
The default number of strongest coupling neighbors is 10 (including self).

3. Ignore mutual capacitance or inductance if the ratio of mutual terms over self term is less than a
percentage.

The default percentage threshold for ignoring mutual capacitance/inductance is 0.005.
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If the mutual capacitance / inductance is less than the 0.5% of the minimum of the two self-
capacitances / inductances, XtractIM does not output the mutual capacitance / inductance.

VIEW /| EXPORT RESULTS

The View/Exports Results options are displayed in the menu bar on the left side of the window.

Click on Summary to open the summary that shows the maximum and minimum R, L, C, and other
information.

-
aptractiy - POP_wirebond,xml - [Surmmary] _ 0O %
1} File  Window  Help Iz‘
JLjH' I | Elj - iExtractorResuIt "E @%5 _‘15 @ b
‘orkFlow: BkractIi ¥ | Extractor Result
Default 2| [Version] 4,1.3.02141

- [Date] nz/1e/2011
Ll
Manage workspace (&) [Package Name] €3\ SigritySamples) SpeedPKG 4.1%XeraceIN Sanples’ Stacked-BGA_f
Load Workspace [Description] Ci\Figritydamples) SpeedPKEG 4.1\ EtractIM\ Sawples' Stacked-BGA_*
Load a Mew/Different Layouk [Hets Extracted] 55
Package Setup VD [Freguency of Extraction] 30MH=
Package Type: Wirebond [HE}X E (mOhm) ] 5410.33
o Circuits [Min Rimom]] 24,8305
o Stackup [HE.U( self—J..nductance LinH)] 5.045392
+ Solder Bal [Hin self-inductance L (nH)] 0.204355
o Nets [Max =self-capacitance C(pF)] 30.0466
) ) P [Hin self-capacitance C(pF)] 1.11825
Simulation Setup ka
Module: IEIS{RLGC
Simulation Type: Met-Based
View/Export Results ka
Surnmary
SPICE Model
Eranch RL
Save Resulks
Load Results
v
[ il
Cukpuk b
Campleting Trace Circuits
Creating Coupled Trace circuits
Preparing Mediurn For Simulation
Preparing Boundary Condition
Computing Edge Reflection Coefficient. ..
* Processing Patch0z -- Patchil
Connecting Circuits To Patches
Handling Floating Circuits
Madeling Pads
Solving Package and Circuits ... E|
Simulation is in progress,
Miscellaneous
Ver: 4.1,3.02141 [SHCME) Mouse(mm): X! -2, 123, ¥: 13.074 O Ready
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SPICE Model
Click on SPICE Model. The SPICE Model name *.ckt is loaded.

r -
aprtractitd - POP_wirebond, uml - [Circuit Topology Result] _ O x
1> File  ‘Window  Help E
RE=A ™ R N B R = [ O ¢ Extractor Resul "@'@%%_Z‘JI} e b
‘orkflove: KtrackIM X | Extractor Result |
' Default

Manage Workspace @ —Wiew Model Selectio
Load Workspace (%) SPICE T-model
Load a Mew/Different Layout ) DC_R of Each Path
Package Setup @ -
- () BLE of Each Path
Package Type: Wirebond
" Circuits O Coupling of Each Path
" Stackup
+ Solder Ball
" Mets
Simulation Setup @
Module: BIS/RLGC .3UBCET POP_w1r§b0nd_.p0p_w1reb0nd_NetBaseSPICE ;
Simulation Type: Met-Based + Diel Diel-12 POPbottom POPhottom-C1
) @ + POPtop POFPtop-Cl
View/Export Results + Diel Die1-135 POPhottom POPbottom-Ai3
Summary + POPtop POPtop-A3
SPICE Model + Diel Diel-96 POPhottom POFbottom-C12
Eranch RL + PCPtop POPtop-Cla
Save Results + Diel Diel-51 POPbottom POPbotCtom-M3 -
Load Pesulks 4 Fe— = — b
Customize Workflow ¥
Cukpuk *
Completing Trace Circuits Y
Creating Coupled Trace circuits
Preparing Medium For Simulation
Preparing Boundary Condition
Computing Edge Reflection Coefficient. ..
* Processing PatchoZ -- Patchal
Connecting Circuits To Patches
Handling Floating Circuits
Modeling Pads
Solving Package and Circuits ... E
Simulation is in progress,
b
Miscellangous | 1=sh - Errors | Varishlescheck |
Wer: 4,1,3.02141 (SHCRE) Mouselmm): ¥ -2,123, ¥: 13.074 a Ready
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Chapter

TCL Command Support for Workspace Setup

This chapter introduces TCL command for workspace setup in the XtractIM tool.

INTRODUCTION

TCL (Tool Command Language) scripts can be used to configure and automate frequently used com-

mand in Allegro Sigrity tools. They can also be launched outside the Sigrity tools in batch mode to
automate company design flows.

New TCL command for XtractIM is developed to support workspace setting. Three types of new TCL
command are available, including Setting up TCL, Doing Simulation TCL, and Creating Report TCL.

For the other existing TCL command, please refer to Tcl_Scripting Reference.pdf in
<ASI_INSTALL_DIR>\Update3\Doc\Common Documents\ for details.

SETTING UP TCL

*  Update Package Type

Format: sigrity::update PackageType -dieType|d {0-2} -bgaType|b {0-2} -attachTypel|a
{0-2} -leadTypel|l {0-2}

Package Setup -» Package Type

(®) Single Die (") Stacked Die (") Side-by-side Die
(®) Single BGA () stacked BGA () Leadframe
O Wirebond @ Flip-Chip O Both

{(WL-CSP)

o [om]

*  Update Circuits
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Format: sigrity::update Circuits -dieCkts|d {circuit name} -boardCkts|b {circuit name} -
capCkts|c {circuit name} -wbCkts|w {circuit name}

[ Wizard x|
- ~
Select the Die/Component circuit from the list and dick Mext
Ckt Mame Ckt Model Die/Board /Componer
Ckt Type

C1 Cap0402

CZx Cap0402

C3 Cap0402

C4 Cap0402

Co Cap0402

CE Cap0402

c7 Cap0402

ca Cap0402

vt [rc___lDe |

BGA1 untilted_pac... Board
n, I,
[ Right-click on a circuit name to select/deselect as Die dreuit J

< Back Mext = | | Cancel |
* Add Layer

Format: sigrity::add Layer {layer type} -above | -under {layer name} -name {new
name} -circuit {die/BGA name} -bind {circuit name} -PCBAbove

Layer Manager -> Stack Up o x
Stack Up | Pad Stack |
Layer# | Color | Layer Icon | Layer Name Thickness(... | Material Conductivity(s... | FilnDilectric | Permittivity | LossTangent | ShapeName | Trace Width(mm) Trapezoidal Angle(?) | Roughness
1 Signalol 0.001 5.8e+007 [ o1 Shape002 0.1 90 0
Bump01 0.1 0 i 0
2 Signal04 0.001 5824007 [ ol 01 a0 [}
o o1 B L b
3 Signal$M L 0.015 5824007 28] ol 01 a0 [}
Mediumsdielectric2 0.125 0 42 0
+ Signal $VDD 0.02 5824007 ©.2 U] ShapeVDD 0.1 %0 [}
Medium $dielectric3 0.25 0 4.2 0
5 Signal$Uss 0.02 5824007 .2 [o] ShapesUss 0.1 50 0
= | Medumsdielectricd 0.125 [] 4.2 0
s | sm= Bowsw —pos | beswy | g o | bt b b |
| Solderbalol 03 0 i 0 1
7 O B sinao2 0.001 5.82+007 25 o 0.1 L 0
| Medumor 0.05 0 % o
8 O BECHE sindos 0.03556 5.952+009 [25] [o] shape001 0.1 50 0
[@®e| solderbaloz 0.5 0 i 0
9 O B sanaos 0.001 5.82+007 [25] [o] 0.1 90 0
] Medumoz 0.05 0 j4 0
10 O ER sonaos 0.03556 5.952-+009 (81] o] shape003 0.1 90 0
[ 1il ]
Total Thickness: 1.7451e-+000 mm [ enforce causaity view Material Import
[¥] Solder Ball Layer [¥] Bump Layer [ Export |[Auto SetLayer Special Void || Filter... |

» Update Attributes

Format: sigrity::update Attributes -circuit|c {circuit name} -Dmax {value} -D1 {value} -
D2 {value} -HT {value} -conductivity|o {value} -mediumThickness|mt {value} -D {value}
-Lu {value} -W {value} -LKvalue} -T {value} -H {value}
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Package Setup -» Bumps

Layer Name

Bump02 UL

Circuit Name

D2 (mm)
0.08

Dmax (mm) | D1 {mm) HT (mm)

0.1 0.08 0.1

Material Conductivity (S/m)

Se?

OK Cancel

Package Setup -> Solder Ball

Layer Name Circuit Name

Dmax (mm) | D1 {mm) D2 {mm) HT {mm) Material

Conductivity (S/m) Medium Thickness (mm)

Solderballoz BGAL 0.4 0.3 0.3 0.951 57 0.05
D1

4] il
[ o [ cancal ]

Package Setup -> Lead

= Simplified Setup () standard Setup
Layer Circuit D (mm) | Lu W (mm) LU(mm) T(mm) H(mm) Material Conductivity Medium Thickness
Name Name (mm) (Sfm) (mm)
[ edumfiickness |
oK ” Cancel |
NOTE The unit for value is meter.
»  Update Options

Format: sigrity::update Options -meshEdgelLength|m {value} -simplifyGeometry|s
{0]|1} -coarseMesh|c {0|1} -narrowGapModeling|n {0|1} -modelCoplanarTraces|pl {0|1}
-filterSignalNets|f {0|1} -enforceCausality|e {0|1} -enhancePadAntipad|a {0|1} -detect-
ViaClearance|d {0|1} -temperature|t {value} -solver {value}

NOTE

The unit for value is meter.

NOTE

The command option “-dieType|d”’can be “-dieType” or “-d”.
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Options

File @®
General
File Manager
Save Options
Hotkeys

Layout ®)

=
|"g), Change the 'Mesh' options in XtractIM

Mesh Edge Length

Grid and Unit
View
Processing
Trace
Error Checking
3D Layout View ®
Display
Quality
Simulation (Basic)
General
Met and Coupling
Special Void
Qutput SPICE Circuit
Repart
Simulation (Advanced) @
Electric Models

Mets and Shapes
Field Solver Engine

0.99( mm

This is the constraint on the maximum length of the triangles in the mesh for finite element simulation in
the field domain. The default value is obtained from the package size.

Mesh quality and coarse option

Simplify the geometry to improve mesh quality
[]coarse Mesh
This option is used when the user would like to run the simulation with a coarser mesh which means a

mesh with less nodes. The size of the mesh will be automatically adjusted. The option may lead to less
accurate result and is not recommended unless a normal simulation runs out of memory.

Default ‘ | Apply | | oK I ‘ Cancel

Options

e 0 ®
General
File Manager
Save Options
Hotkeys
Layout (‘3
Grid and Unit
View
Processing
Trace
Error Checking
3DlayoutView &
Display
Quality
Simulation (Basic)
General
Met and Coupling
Spedal Yoid
Qutput SPICE Circuit
Report
Simulation (Advanced) @
Electric Models
Mesh

MNets and Shapes

Field Solver Engine

-
[“& Change the 'Nets and Shapes® options in XtractIM

Net Options

D Filter signal nets

If there are too many signal nets in the design, those far away from the ones of interest can be turned off
automatically to accelerate the simulation,

Shape Options

D Consider coupling between field domains through narrow gaps
D Detect and model the coplanar traces coupling with field domains

Default ‘ ‘ Apply | I [o]'4 I | Cancel
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Options ®

e ® k
General |“& Change the 'Electric Models' options in XtractIM
File Manager
Save Options
Hotkeys i Pad and Antipad

Lyour  ®
Grid and Unit
View
Processing Detect actual via dearance
Trace
Error Checking

3D Layout View O]
Display
Quality Dielectric

Simulation (Basic) (%)
General D Enforce causality in material parameters {option also available in the Stackup dialog)
Met and Coupling
Spedal Void
Qutput SPICE Circuit
Report

Simulation (Advanced) [’3
Electric Models
Mesh
Mets and Shapes Set Temperature

Field Solver Engine
Temperature 25,000000 oC

Use enhanced Pad/Antipad model to extract the capadtances

Default ‘ ‘ Apply | I oK I | Cancel

»  Update Extraction Frequency

Format: sigrity::update ExtractionFreq {Value}

Extraction Frequency x

Extraction Frequency: |3D | MHz "

NOTE The unit for value is Hz.

*  Update Mode
Format: sigrity::update Mode {Value}
value: “Extraction” | “EPA”

‘>XtractIM - Untitled - [flipchip.spd Layer View]
- Waorkspace Edit  View | Mode Setup  Tools  Window Help
RN (=R | Maodel Extraction =

E’ﬁ” Enabled Net(s) |v| @ll— v Elec. Perf, Assessment (EPA) R = '_$

*  Update Simulation Type
Format: sigrity::update SimType {Value}
value: “Net-based” | “Pin-base”
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Simulation Setup -> Simulation Type

Model Extraction
(@i NetBased () Pin-Based

*  Update Reference Net
Format: sigrity::update RefNet {Net name}

Simulation Setup -> Simulation Type
Model Extraction
it Use Refer Net
O hetBased @) Pin-Based Layer Circuit Name: CraitModel i Ise Reference N
T T Use e i)
Signals4. BGAL untited_package Use Reference Node(manual)
E=N
() Use Reference Element [Element I0: (0, 0)
(C)Use Grouped pins in MCP Header
Load HCP header file
o |[ cancal

»  Update Coupling

Format: sigrity::update Cpl -risetime {number} -percent {number} -all —.group{power,
ground, signal, unnamed}

| Het Mansger

=
=
=
=
=
2 F BHoonde: 3 100
H Ev
B Joerant 3 109
FE  Evet 3 ila:]
F  Etetz 3 10
F  Etet s 3 10
F  Evets 3 10
= 3 L0
= 3 L0
B Ener 3 L
B Euers 3 )
B Eues 3 o)
B Enewn 3 o)
B net_un 3 10
B Enet 1z 3 1]
B Evet_13 3 1]
B Enet_a4 3 100
Bl Ene s 3 10
| B Enet 16 3 100
el
[+] Kimseps s mnaibiad when the nat s desbled
[#] Gray tusabled [rde tasabled
Cougled Lines
[l cisable Coupled Line Smuabon
Coupled Uines Regert

DOING SIMULATION TCL

Format: sigrity::begin simul
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CREATING REPORT TCL

Format: sigrity::do GenReport -template {File Name Path}

Format: sigrity::save Report —Filename|F {New File name Path}

ELECTRICAL PERFORMANCE ASSESSMENT (EPA) TCL

Format: sigrity::update PGAnalysis -inductanceAndCapacitance|i {0-1} -bbandimpedance|b
{0-1} -freq|f {Value in GHz} -groupedPinProps|g {0-1} -dcResistance|d {0-1} -loopInductancel|l
{0-1} -perPinRLSide|p {0-2} -pinGroupX|x {Value} -pinGroupY |y {Value} -nets|n {Net names}

-all

Format: sigrity::update SignalAnalysis -impedancel|i {0-1} -coupling|c {0-1} -mutualLC|m {O-

1} -loss|l {0-1}

-freq|f {Value in GHz}

Format: sigrity::update CurrentAnalysis -checkCurrentDensity|c {0-1} -nets|n {Net names} -
sinkCurrent|s {Value in A} -all

USER-FRIENDLY DESIGN

In the TCL Command window, three user-friendly functions are designed.

You can:

*  Choose TCL command with the same keyword from the pull-down menu

+  Click " to get the TCL command history

»  Refer to the auto-tips presented when you are typing the TCL command

| TCL Command

- | sigrity::

| sigrity:

| sigrity:
'sigrity: -
== sigrity::
sigrity:
sigrity:
sigrity:
sigrity:
sigrity:

:close

:hegin_-

scheck] =[FCL Reader|

clear . 1 654, Y -10.692

Click to get history _,

@ Ready

Run

cls
icopy
delete
:do
zend
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TCL Command X
sigrity::update PackageType -dieType {0} -bgaType {0} -attachType {1 ]
; sigrity::update PackageType -dieType|d {0-2} -bgaType|b {0-2} -attachType|a] Run
0-2 0-2}|I

| [TCL Command| TCL Reader | B ——
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Error Checking Your Files

Cadence provides a number of tools to help error check your files before running a simulation. Some
file errors can be hard to find. For example, you may think a trace is connected to a via — they appear
overlapped with each other — but actually, the nodes of the trace and the via may not be connected.

Using the error checking tools of the software, you can easily spot these kinds of drawing problems.
Another kind of error is related to our internal computation models and their need to numerically dis-
cretize the geometries.

USING THE ERROR CHECKING TOOLBAR

The Error Checking Tools can assist you in finding different types of warnings and errors. Whenever
a problem is detected during error checking procedures, an error or warning symbol appears in the
problem area.

Error Symbols

The error symbols are similar to the button icons in the toolbar. There are four types of warnings and
two types of errors.

Short Circuit Check

I |
Floating Hodes — @ . [i] == Reveal Errors

Open Circuit  Check All Layers
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Display the Error Check Toolbar

Select

View > Toolbar > Checking

UNDERSTANDING THE OUTPUT WINDOW

The Output window allows you to view warnings and errors at a glance whenever you open a .spd file.
These tabs are located located at the left-side of the lower window.

*  Mesh Errors — Lists all the GUI related errors that you can use the Error Checking toolbar to
find. This tab lists all the warnings and errors that the application finds.

*  Miscellaneous — Lists all the errors inherent in a given file, such as an incomplete partial cir-
cuit definition or layers with a thickness of 0.

*  Variables Check — Lists all the variables checked.
To display the Output Window, select
View > Output Window

Check for Warnings & Errors

1. Select which package elements you want to display or hide. Choose from:

*  Nodes

e Pads

*  Shapes
*  Traces

* Vias

*  Wirebonds

2. Use the bottom buttons of the Layer Selection dialog.

algl=t /@0

3. Choose the types of warnings and errors that you want to find.

Via Placement and Node Placement errors are the default choices.

4. Press | to check for errors on the active layer.
5. Press to check for errors on all layers.

Warnings and errors found are marked with symbols similar to the buttons on the Checking Tool-
bar. These errors are listed in the Qutput Window and are marked in the Layer View area.

6. Double-click on any error that you wish to view in the Output Window. The Layer View win-
dow zooms into the area where the error is located.

7. Correct any errors or warnings.

NOTE! All errors must be corrected prior to simulation.
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Mesh Errors Listed in the Output Window

Outpuk x

WARNIMNG [Open Met]: Met Unnarmed ket(s) contains bwo or more disconnected sections,
WARKIMNG [Dpen Met]: Met _Floating_Plane_net contains bwo or more disconnected sections,

Mesh - Errors

ERROR CHECKING YOUR FILES 29
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Check for Short Circuits

This feature lets you check for short circuits in your simulation. Short circuit warnings are displayed
using a icon. There are three kinds of Short Circuit Nodes:

»  Package objects of different nets are connected together.

»  Package nodes of different nets are linked to the same circuit.

* A port’s positive and negative terminals connected to the same net.

NOTE! For this type of checking, objects or nodes of unnamed nets are treated as if they
- belong to the same net, and this net is different from any other net.

1. To start checking select
Tools > Check > Check Activated Layer

or

Check All Layers
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Any warnings found are listed in the Output Window and are shown in the Layer View area.

Bt E.I.' ....|.Ef.tl....| .l?fl...u

ot )

a1,

—£°g
L

¥l

Iy ...|§.h

zh

A

I....|..ﬁ]....| ..ﬁ....lﬂ.ﬁl...n N

4

A

kgt

WARNING [Short Circuit]: Node2387112::END (1.533mm, 20.296mm) on layer Signal§TOP shorts the Following nets, YCC and GND
WARNING [Short Circuit]: Node2472: :WCC (2.642mm, 20.320mm) on layer Signal§ TOP shorts the Following nets, GND and WCC
WARNING [Shaort Circuit]: NodeZ389::GND (1.533mm, 20.296mm) on Laver Signal§BOTTOM shorts the Foliowing nets, YOO and GND
WARNING [Short Circuit]: ModeS05::WCC (2.642mm, 20.320mm) on layer SignalfBOTTOM shorts the Fodiowing nets, GND and WOC
i.n\-‘Aﬂh.l]NG [Node Short Package Nodes]: capé.0 shorted the following package nodes, Node2472::WCC and Node2387112::GMND

Mesh - Errors

2. Double-click on any warning in the Output window. The Layer View window zooms into the
area where the short circuit is located or the Circuit Manager is displayed.
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Case Examples

This chapter outlines some case examples for various sections of the XtractIM User’s Guide.

EXTENDING NODES AND VIAS

TheExtending Nodes and Vias illustration represents the nodes and vias that are to be extended verti-

cally.

Nodes: node06, node07, node08, node09 and nodel0.
Vias: vial2, vial7, vial3, vial6 and viall.
Via 12 is terminated at node06 on layer Signal02 and node25 on layer Plane02.

Node07 does not extend vertically through a via but, vial3 is in vertical proximity (to node07)
as is vial7.

Vial7 and vial3 share node26.
Node28 is the upper node of vial6.
Node29 is the lower node which is in vertical proximity to node138 of layer SignalO1.

Viall is included to complement the example.
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Extending Nodes and Vias
The purpose is to insert vias in the following manner:

Isolated node objects extended vertically by the insertion of vias.

Where a via already exists, the via is extended.

Signal02
node09
node07 node08 node10
1 I I Plane02
via12 node12 I IVB]]
node28
node25 =
vial3 I I Plane01
node26 vial6
viall
| S|
node29 node24

Signal01

Refer back to this illustration as you study the examples in Case 1 and Case 2.

CASE EXAMPLES 104



Extending Nodes and Vias XtractlM User’s Guide 16.6

CASE 1

The via in the Via Extension window shows we want to extend nodes selected from layer
Signal02 to layer SignalO1.

Only Node09 can be extended as indicated.

All other nodes have existing vias blocking the extension.

Properties of Extended Wials)

Info:

Properties will be inherited
fFrom the attached wia if
b is checked.

Inherit Padstack

Inherit Met Color

Inherit Conduckivity

Wias or nodes cannot be extended ¢

Wias or nodes can be extended :

| WiaOes0

(o] 4 I | Cancel
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CASE 2

The via shows we want to extend all nodes and vias from layer Signal02 to layer Plane02.

Nodes 9, 8, and 7 can be extended.

Vias 13 and 16 can be extended.

Vias 12, 17 and 11 cannot be extended.
Existing vias are blocking nodes 6 and 10.

Via17 is blocked by via13.

Properties of Extended Wia(s)

Info:

ES@METOP Properties will be inherited

Mediurnz from the attached wia if

ELEEL Hsonation rbdEed

Medium4

=== W SEnEh ] Inherit Padstack

Medium$a

EL_EEL Hsioniiis4
e

Mediuma

= M= = W SELHG ] Inherit Het Color

Medium$10

E_EEL Hsinaeottom

| Inherit Conduckivity

Wias or nodes cannot be extended ¢

Wias or nodes can be extended :

Wialas0

Zancel

Zancel
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Propterties of Extended Vias Window

Properties of Extended Wials)

Info:

Properties will be inherited
fFrom the attached wia if
b is checked.

Inherit Padstack

Inherit Met Color

Inherit Conduckivity

Wias or nodes cannot be extended ¢

Wias or nodes can be extended :

Wialas0

Ok | | Zancel

CASE EXAMPLES 107



Extending Nodes and Vias XtractlM User’s Guide 16.6

CASE EXAMPLES 108



Quick GUI Keys

Chapter

The Quick GUI Keys are listed and described in the following table.

GUI KEY FEATURES

FEATURE KEYS TO PRESS | NOTES
Active layer selection Up and Down Use with the Layer Selection dialog.
Arrows
Close windows ESC Closes any open dialog box that is currently active.
Finding objects, Ctrl+F Works when the Layer View window is active.
opening the Find dialog box
Show/hide shapes F7 Works with either Layer View or 3D View windows.
Area zooming F2 Zooms into an area. Use the mouse to select what
area you want to magnify.
Zoom back F3 Zooms out of an area.
Zooming in F4 Magnifies a given area. Click the mouse to zoom
into an area.
Zooming out F5 Zooms out of a given area. Click the mouse to
zoom out of an area.
Deleting objects Delete key Works when the Layer View window is active,
select an object, then press the delete key.
Circuit linking “turbo” Up, Down, Use these keys to iterate through the partial circuit
Right and Left and component name lists and to navigate around
the Component Manager.
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FEATURE KEYS TO PRESS | NOTES

Create new .spd file Ctrl + N XtractIMI must be invoked and the workspace must
be empty.

To open a .ximx file Ctrl+ O XtractIM must be invoked and the workspace must
be empty.

To print window contents Ctrl+P Use with the Layer View or 3D View window active.

To save the .spd file Ctrl+ S Use with the Layer View or 3D View window active.

Object Outline Display Ctrl + Shift + O Object outlines are toggled.

QUICK GUI KEYS
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Pin Mapping

Pin mapping is used to indicate which power and ground buses a given driver, receiver, or terminator
is connected. This chapter covers how to use pin mapping in XtractIM.

PIN MAPPING DIALOG

The Pin Package Nodes Match dialog shows the result of name matching and coordinate matching
when a partial circuit includes an MCP or CPM sub-circuit. When the dialog opens and name matching
is failing, you can match coordinates with the default tolerance automatically one time.

When names are matched, the controls used in the manual match are gray.

Function Description

Position Tolerance The tolerances are used in coordinate matching.

Angle Tolerance The tolerances are used in coordinate matching.

Default Set the tolerances to default values.

Match Play coordinate match.

Detail Show the result of name matching and coordinate matching.
Use manual match Select two pairs of points to coordinate match.

Flip pins Flip the pins to match coordinate.

Coord Match Select the result of coordinate match as the final result.
Name Match Select the result of name match as the final result.
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Pin Package Nodes Match Dialog

-
MCP Editor
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SRR U1-A1 R o g

U1-A2
U1-A3
U1-A4
U1-AS
U1-A5
U1-A7
U1-AS
U1-A9 e
U1-A10 Ne 1.6342 2.5681 U1-A10 1-A10 et_82 1.6342
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Filter: l:l L ¥R Connect
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I
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PIN MAPPING 112



Index

XtractlM User’s Guide 16.6

Index

Symbols

.brd 25

.csv file 51, 78, 79, 81
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prepare for the simulation 11
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reorder the list 46
report results 3, 18
Resistance 44, 52
resistance 73

result 54

result display 74

result file 54

result output file 54, 79
result spd file name.eim 54
result*.eim file 54, 79
reverse crosstalk 38
Rise Time 38

Rise Time Value 38
RLC Distributions 52
RLC distributions 52
RLC extraction 35, 66
RLC Full Matrix 54
RLC Full matrix 46
RLC Per Net view 74
RLCG 13, 73

run a simulation 3

run simulation 13, 73
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show/hide shapes 109

signal net 35, 52, 66

signal net length 54
Signal$Bottom layer 64
simulation 73
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